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Welcome
What is the F10-RT used for?
The Filmetrics F10-RT is used to measure the reflectance and transmittance of thin films. With the proper
software options film thickness and refractive index can also bemeasured. Measured films must be
optically smooth and flat in order to bemeasured. Commonly measured films include semiconductor
process films such as oxides, nitrides, resists, and polysilicon, optical coatings such as hardness and anti-
reflection coatings, flat panel display films such as polyimides, resist, and cell gaps. Films that cannot be
measured include very rough films and metal films.

Warning:Accurate measurements require suitable recipe settings and a valid baseline. Improper system setup or
an aged lamp may also lead to errors. It is the user’s responsibility to ensure that this instrument is being used
properly for its intended purpose. Please contact Filmetrics support for assistance with any questions.
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Safety, Maintenance, and Care

This symbol indicates information or instructions that must be read and carefully followed to prevent
hazards, injury to the operator, or damage to the instrument.

This symbol indicates a potential shock hazard. Areas marked with this symbol should be serviced by a
trained service technician.

This symbol indicates that the product conforms to theWEEE (Waste in Electrical and Electronic
Equipment) Directive 2002/96/EC.

This symbol indicates that the product meets the applicable EU safety, health and environmental
protection directive requirements.

This label indicates theModel Number and Serial Number of the instrument. This information may be
necessary when contacting Filmetrics for assistance.
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Disclaimer: Use of this instrument in a manner inconsistent with the information and directions included
in this manual may impair the protections designed into the product resulting in danger to the operator
or damage to the instrument.

Installation Location:When deciding on a location for the instrument, ensure that the instrument is
installed in a well-ventilated location. Enclosing the unit, or blocking the vent holes, may impair the
performance of the instrument or damage the internal components.

Cleaning: The need for periodic cleaning of the system is based on the cleanliness of the environment in
which the system is installed. Only the external surfaces are to be cleaned. Cleaning and maintenance of
all internal components is to be performed by a trained service technician. Do not use aerosol, or spray,
cleaners as they may contaminate the sensitive optical surfaces on the instrument.

Before performing any service on the instrument ensure that themain power is disconnected.

Cleanroom, or low lint, wipes should be used to wipe down the system. Amixture of Isopropyl Alcohol
(IPA) and De-ionized Water (DI H2O) at 70%DI H2O: 30% IPA is to be used for cleaning. Undiluted IPAmay
be used, if the 70:30 DI and IPAmixture is not available, but extra caremust be taken. Avoid using
stronger solvents, such as acetone, as thesemay compromise the surface finish.

Avoid excessive pressure on any surface when cleaning. Excessive forcemay bend a component, which
would damage the system, or cause the system to be out of alignment.

Start with the top of the system and work down. Use slowmotions, in a straight line, from the back to
the front of the surface being cleaned. Change the cleaning wipe periodically to avoid re-depositing
material back onto the surface being cleaned. Allow all cleaned surfaces to dry completely before
restoring power to the system.
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CE Mandated Warnings

Please read the following instructions carefully to prevent potential shock or fire hazards. This manual
should be retained for future use

Bitte lesen Sie die nachstehende Anleitung sorgfältig durch, um Stromschlag und Feuergefahr zu
vermeiden. Diese Betriebsanleitung soll für späteren Gebrauch sorgfältig aufbewahrt werden.

Preghiamo di leggere accuratamente, le sequenti Instruzioni, per evitare Prossiomi Incendi e Correnti.

Shock Hazard - Do Not Enter
Achtung Hochspannung - Nicht Berühren

Attenzione Corrent-Forte - Prego non toccare

The front panel’s switch is not the power disconnect device. The power cord should be removed after
use.

Der Kippschalter an der Vorderseite unterbricht nicht die Stromzuführung. Das Stromkabel soll nach
Gebrauch aus dem Gerät herausgezogen werden.

L’interutore nella parete frontale non blocca le Corrente. La Corrente viene.

Never expose the unit to water or liquids. Avoid direct sun.
Bringe das Gerät nicht mit Wasser oder anderen Flüssigkeiten in Berührung. Vermeide direkte

Sonneneinstrahlung.
Evitare contatto con acqua oppure liquidi Infiammabili al Macchineggio. Auche entrate di Sole.

Do not insert any objects into the unit.
Keinen Gegenstand in das Gerät einbringen. Do non inseriamo any obietta into gli unità.

Non mettere ogetti dentro la Macchina.
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Do not use near open flame or heat.
Das Gerät nicht in der Nähe einer offenen Flamme oder Hitze benutzen.

Non mettere la Macchina vicino a fuochi oppure Riscaldamenti.

The unit should never be enclosed or blocked.
Das Gerät darf nicht eingeschlossen oder blockiert werden.

La Macchina non chinderla per nessun motivo.

Connect unit only to a properly measured supply with a reliable earth ground. Use only the three wire
cord which is provided with the unit.

Schließen Sie das Gerät nur an eine ordnungsgemäss vermessene Stromsversorgung an. Verwenden Sie
nur ein dreiadriges Kabel, wie es auch mit dem Gerät ausgeliefert wird.

Montare solo con misura normata. Adoperando solo 3 cavi elettrici cosi come e fornita la
Macchina.
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1. Software Overview
The way that light reflects off a thin film is determined by the characteristics of the film, such as its
thickness, optical constants, and roughness. The F10-RT is able to determine thin-film characteristics by
first carefully measuring the amount of light reflected from and/or transmitted by the thin film over a
range of wavelengths (i.e., by measuring the reflectance and transmittance spectra). It then analyzes this
data by comparing it to a series of calculated reflectance and transmittance spectra. Most of the features
of the FILMeasure software that runs the F10-RT can be divided into reflectance acquisition and
reflectance analysis functions. The following pages outline themain features of the FILMeasure software.
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1.1 The Measure Tab (Spectra Mode)

1. Standard Windows Menus, including; File, Edit, Setup, Acquire, and Help.

2. These tabs are used to select between theMeasure and Historywindows.

3. Displays the result for themeasurement based on the settings in the Recipe and Alarms Tab. 

4. Displays measurement status, including whether a spectrum is being acquired, analyzed, or the
measurement result. If any alarms have been set in the Alarms tab this box will also be green or red
dependent on if themeasurement was good, defined as within the provided parameters, or bad.

5. Users may select saved recipes from the drop down list, or enter into the Edit Recipe dialog box. On
thickness enabled systems, users can also select between the Spectra and Thickness, n, k, r tabs.

6. This box provides more details about the calculated average reflectance or transmittance, min or max
values, and theGoodness of Fit (GOF).

7. Graphical display for spectra. A click of the right mouse button while the cursor is within the graphical
display opens the belowmenu for easy reading of cursor values in themain FILMeasure window. The
keyboard up/down and right/left arrows move themarker to a desired location.

The graph limits can be changed by double-clicking on the graph display.The text boxes along the bottom
of the graph control the wavelength range, in nanometers, displayed on the screen. The two on the left
represent the Reflectance (%) range, with themax being set in the upper box and themin being set in the
lower. The boxes on the right are for Transmittance (%). Check the Auto checkbox to activate y-axis
autoscaling. The lower value is always 0 for autoscaling; themaximum y-axis upper limit is 5000. The axes
can be set to display in percent or as a decimal value (100% = 1). 
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Graph Options can be accessed and edited by double-clicking on the main graph window.

8. This section provides the controls for the SampleCam.
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1.2 The Measure Tab (Thickness Solving Enabled)

There are a few differences in themain interface for F10-RT systems with the UPG-RT-to-Thickness.
Unlabeled options below are the same as the standard F10-RT and information regarding these options
can be found in the section FILMeasure Main Window.

1. The thickness result is displayed here.

2. Allows the user toMeasure a sample, Baseline the system, or Analyze an open spectrum.

3. In addition to editing acquisition parameters, on systems with thickness enabled Edit Recipe… is
where the film stack and analysis parameters are set.

4. Graphic display for measured and calculated spectra. Display limits can be changed by double-clicking
in the display area. A click of the right-mouse button provides a drop down list for reflectance tracking
options.
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1.3 The Measure Tab (n and k Solving Enabled)

For F10-RT systems with the UPG-Thickness-to-n&k, if n and k aremeasured, themain FILMeasure
screen shows both the acquired spectrum and the dispersion curves for both n and k (see the image
below). If only thickness is measured, then the dispersion curves are not displayed, and themain
windowwill look the same as the F10-RT with the Thickness Upgrade only.
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1.4 The History Tab

1. Standard Windows menus, including; File, Edit, Setup, Acquire, and Help.

2. Click on these tabs to select between theMeasure and Historywindows.

3. Used to alternate between the Single Measurement andMeasurement Trend tab. Selecting the
Measurement Trend tab will allow the user to see a plot of themeasurement results versus
measurement number. A drop-down list allows the user to select between which parameter is displayed.
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When the Measurement Trend tab is selected in the Historywindow, the right side of the screens graphs the
results.

4. Shows themeasurement results for the selected spectrum (must be in Single Measurementmode).

5. Displays the selected spectrum in Single Measurementmode or themeasurement trend plot in
Measurement Trendmode.

6. Displays statistics for all measurements included in the history file. This data can be selected for
copying and pasting outside of the software.

7. This list contains all spectra currently included in the history file. Left clicking on a column header will
re-sort the data in ascending or descending order based on the selected column. Right clicking anywhere
is this box will allow the user to open the Edit Columns control panel.
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1.5 The Edit Recipe Window (Spectra Mode)

1. These buttons allow you to, in order from left to right:
i. Open a saved recipe.
ii. Start a new recipe.
iii. Save the current settings.
iv. Save the current settings as new recipe
v. Delete the current recipe.

2. Opens a drop-down list for quick access to saved recipes.

3. Author as defined by user login name and recipemodification date is indicated here.

4. Allows the user to select between the Spectrum Analysis and Acquisition Settings tabs.

5. Users can select a representative or Target Spectrum to compare newly acquired spectra to. The
selected spectrum will appear in themain FILMeasure screen.

6. Allows the user to switch between theMin/Max, Average Reflectance, Alarms, and
Spectrum Preprocessing tabs.

7. Controls for the currently selected spectrum analysis mode are shown here. Specifics on how to use
these controls can be found under Editing Film Recipes > Spectrum Analysis.
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1.6 The Edit Recipe Window (Thickness, n, k, r mode)

The Edit Recipewindow is used to define the film stack and to set analysis and acquisition parameters.

1. These buttons allow you to, in order from left to right:
i. Open a saved recipe.
ii. Start a new recipe.
iii. Save the current settings.
iv. Save the current settings as a new recipe
v. Delete the current recipe.

2. Opens a drop-down list for quick access to saved recipes.

3. Author, as defined by user login name and recipemodification date is indicated here.

4. Allows the user to select between the Film Stack, Analysis Options, Alarms, and Acquisition Settings
tabs.
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5. The desired thickness units are chosen here. The choices include angstroms (Å, 10^-10m), nanometers
(nm, 10^-9m), kilo-angstroms (kÅ, 10^-7m), microns (µm, 10^-6m), microinches, mils, millimeters (mm,
10^-3m), and Custom Units.

6. This is where thematerials and parameters to be solved are defined.
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1.7 Menu Controls

This section describes the various functions available through the standard Windows FileMenus.

File Menu

Edit Menu

Setup Menu

Acquire Menu

Help Menu

1.7.1 File Menu

Open Spectrum… (Measure Tab only)
This command is used to open stored reflectance spectra, which are then displayed and can be analyzed
for film properties.

Open History…
Previously saved History data containing measurements and statistics can be loaded with this
command.

Import: Recipe…
Import recipes that were previously exported or created with an older version of FILMeasure.

Import: Material…
Import materials not currently in the software either created by the user or provided by Filmetrics.

Import: License…
When the user purchases an upgrade for the system, Filmetrics will send a license file to the user. The
licensemust be imported into the software before upgrades are effective.
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Save Measured Spectrum… (Measure Tab only)
This command is used to save spectra for export or later analysis. Files can be saved in four different
formats:

*.fmspe: This file can only be opened in FILMeasure 5.0 or greater and is the preferred way to save
spectra. Additional information from data acquisition is stored in this file.

*.spe: This file can be opened in all versions of FILMeasure.

*.csv: This is a comma-delimited file that can be opened directly in Excel.

*.txt: This is a tab-delimited file and can be opened with a text editor.

Save Screen to File… (Measure Tab only)
This command takes a screenshot of the FILMeasure window.

Save n and k to files… (Measure Tab only, n & k upgrade required)
This command is used to save the calculated n and k data to its own material file for use in the Edit
Recipe>Material list boxes. All data is saved along with the corresponding wavelength data in comma-
delimited format.

Note: This option is only present when optical constants are being solved for. (UPG-Thickness-to-n&k
required)

Export: Recipe…
Recipes can be exported for use on other computers running FILMeasure. The exported file will also
automatically include any material files required by the recipe. To duplicate an analysis, all that is needed
is the exported recipe and the spectrum being analyzed.

Export: Recipe for FILMeasure 4…
This command will convert a recipe for use with FILMeasure 4. This will not includematerial files or recipe
features only available in later versions of FILMeasure.

Export: SystemInfo File…
For certain software upgrades , the user will be required to send the SystemInfo file to Filmetrics which
can be exported using this command.

1.7.2 Edit Menu

This menu allows access to theMaterial Library.
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Material Library
Thematerial library is used to display information about existing materials as well as create new ones.
Material files shipped with FILMeasure have the file extension “.fibnk” and will only display limited
information. User created material files, ".fitnk", can be plotted on a graph or viewed in table form.

A newmaterial may be entered into thematerial library manually if refractive index (n) and extinction
coefficient (k) are known as a function of wavelength for the newmaterial.

To create a newmaterial file:

1. Select Edit > Material Library…menu item. The Edit Material dialog box will appear.

2. Click New… to create a newmaterial.

3. Select the type ofmaterial you are ready to create (Dielectric, Photoresist, Semiconductor, Metal,
or Other).

4. Optimize the functionality of the file by entering index values over the entire wavelength range of
the system. The wavelength unit is nanometers. Enter index information every 20 to 50 nm,
depending on the complexity of the data. In areas where n or k is quickly changing, more densely
spaced points should be entered.
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5. Alternatively, select theModel > Custom radio button and click theDetails button. A Custom
Model Information dialog box will appear. Select the appropriatemodel. Enter in the known
coefficients and click OK. Cauchy coefficients are displayed in microns. If they are entered in Å,
FILMeasure will automatically detect this and convert them to microns.

6. Click the save button to save thematerial. You will be asked for a filename, and you may select
one of two file types:
*.fitnk: Creates a unified file with both n and k information. Compatible with FILMeasure 5 and
beyond.
*.nnn: Creates a *.nnn file and, if there is k in thematerial, a *.kkk file to contain material data. For
files with both n and k, the two files must have the same filename, for example xmaterial.nnn and
xmaterial.kkk , in order for FILMeasure to properly indentify them. Compatible with all versions of
FILMeasure.

1.7.3 Setup Menu

This menu contains the settings for manually obtaining the Standard/Background information, Display
options, and the Raw Signal dialog. This is also where user access can be set through the Access Control
option, as well as modifying some system Options.

Standard/Background
This control is used when manually taking and enabling/disabling the Reflectance Standard and
Background compensation.
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Take Standard
This button allows the reflectance standard portion of the baselinemeasurement to be taken without
having to re-take the background measurement.

Take Background
This button allows the background portion of the baselinemeasurement to be taken without having to
re-take the referencemeasurement.

Use Standard
This checkbox allows the reflectance standard portion of the baseline correction to be enabled or
disabled. This box is only available if a baseline has already been completed.

Subtract Background
This checkbox allows the background subtraction portion of the baseline correction to be enabled or
disabled. This box is only available if a baseline has already been completed.

Display

Color Measurement Settings: Color Space
The color of a spectrum can be displayed and quantified on themain screen if a color space coordinate
system is selected.
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When a Color Space is selected, the color of the spectrum and the coordinates appear on the Measure Tab.

Color Measurement Settings: Observer
When a specific color space is chosen for display, this option allows the user to choose between the CIE
1931 2 degree observer and the CIE 1964 10 degree observer. Note that this variable is associated with
the CIE eye-response convention (see, for example, http://en.wikipedia.org/wiki/CIE_1931_color_
space) and is unrelated to the illumination or collection angle of themeasurement.

Color Measurement Settings: Illuminant
This setting refers to the standard illuminant being used by the software to help determine the results of
the color analysis.

Color Measurement Settings: Fixed Luminance
The user can fix the luminance of the displayed color. Since antireflective coatings, for example, are
inherently transmitting, the spectra have very little luminance and the coating color may appear black on
the screen. Adjusting the luminance does not affect the color space coordinate results.

Spectrum colors of the same spectrum with fixed luminance of 10%, 40%, and 70%, respectively.

Color Measurement Settings: Restrict Wavelength
Restrict the wavelength range analyzed when performing color analysis. When disabled the analysis
defaults to

Number of Spectra
This sets themaximum number of spectra (up to 10) displayed simultaneously on themain FILMeasure
screen. If themaximum number of spectra is reduced to fewer than the number already on the screen,
themost recently selected spectra will remain.

http://en.wikipedia.org/wiki/CIE_1931_color_space
http://en.wikipedia.org/wiki/CIE_1931_color_space
http://en.wikipedia.org/wiki/Standard_illuminant
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You may also use the Show Dual Spectrum Graphs option to display two measurement graphs
concurrently. The data will remain the same across both graphs (spectra and modeled fit), but you can
set the graph options for both windows independently. This can be used to focus on a specific area of
interest on a spectra while still seeing the effects on the dataset as a whole.

Spectra Transformation
For spectra with both reflectance and transmittance information present, you can have the software
display them as separate spectra (none), added together (sum), or the absorptance (1-R-T).

Graph Options
The background of the graph can be set to white or black using this option, as well as allowing the
software to auto-position the legend box to avoid or minimize overlap with the displayed spectra.

Measurement Results: Significant Digits
For systems with the thickness upgrade, the user can select the number of significant figures, from 1 to 7,
that the results are displayed in. For example, with the units set to Angstroms and 4 significant digits,
The software would report a thickness of 7213 Å. If significant digits is switched to 3, it will instead display
the thickness as 7210 Å.

Displayed Controls
These checkboxes are used to determine which controls are shown on the right hand side of the
FILMeasure window. Some options may not be available based on current system configuration.

Access Control
FILMeasure incorporates password protection to limit access to themeasurement software and settings.
When the software is initially installed access control is turned off. The software will automatically boot
up with Engineer level access that enables access to all features of the program except turning on and off
access control and adding and deleting users.
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Turning on access control requires Supervisor level access. The software is delivered with one user, a
supervisor, in the list of authorized users as shown below:

UserID: filmsuper

Password: filmetricsfff

To turn on access control log in as filmsuper using the password shown above. The Activate Access
Control checkbox should selected enabling access control functions. User ID and Password are case-
sensitive.

To add an operator level user, select operator from the Access Level list box then type a user name and
an initial password for that user. Then click the Add User button. To add an engineer or a supervisor user
follow the same procedure, but first pick the appropriate access level from the list box before pressing
the Add User button.

To delete a user, enter theUserID and press theDelete User button.

Operator and Engineer level users can change their passwords when they are logged in by entering their
password into the password box and pressing the change button. Supervisor-level users can change
their password or the password of any other user by selecting the appropriate access level, entering the
appropriateUserID and the new password and pressing Add User. If the program finds that a user
already exists, it will delete the old entry for that user and create a new entry.

We recommend that you create a new supervisor level user and delete the filmsuper user for maximum
security. If all supervisor level users forget their passwords, it will be necessary to re-install the software
and add all the users again.

Raw Signal

Raw Signal
The Raw Signal dialog box allows the user to plot the raw (no baseline corrections applied) spectrometer
signal on themain graph. This is useful when setting integration times manually.
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Measurement Subsystem
This drop-down list allows you to select between collecting raw signal
from the reflectance or transmittance spectrometer(s).

Active Spectrometer
For systems with multiple spectrometers (EXR and UVX) these radio
buttons allow you to select between collecting data from the short
wavelength, long wavelength, or both spectrometers. Note that the
software will automatically adjust the x-axis of the graph to match
maximum wavelength range the selected spectrometer configuration.

Integration
The user can set the integration time and the number of integration
cycles for the spectrometer. Increasing cycles can be used to help
smooth the data being returned to FILMeasure. Clicking Applywill show
the changes in themain graph window. Clicking Update Recipe transfers
the listed integration time and cycles to the current recipe.

Signal Corrections.
Spectrum Preprocessing allows the user to apply a smoothing function
to the displayed spectra. See Editing Film Recipes > Data Selection for
more details.

Subtract Background can be used to remove the inherent background
signal from the displayed raw signal spectrum.

Start/Stop
This button starts/stops the acquisition of the spectrometer signal.

Graph Limits
This allows the user to either manually set or autoscale the graph limits. Click Apply after any changes to
display them on themain FILMeasure window.

Options
TheOptionsmenu allows the user to enable, disable, or modify several different settings within
FILMeasure.

General Settings

Data Recording

Calibration
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General Settings

TheGeneral Settings tab is used to enable, disable, and modify various options in the software.

Hide or show themenu bar when using Save Screen
to File.
Enable or disable whether the software displays a
warning before clearing all spectra on the screen
when the Clear Graph button is pressed.
Enable or disable automatically increasing the
number of spectra displayed on the graph when
opening multiple saved spectra.

You can also set whether to show a confirmation
message before increasing the number of spectra.
Toggle whether the software prints out all currently
loaded spectra, or only the active curve when using
the Print feature.

Enable or disable whether the warning dialog before
you delete entries in the history file.

Open a dialog that allows you to control which
columns are visible in theHistory tab.

Enable or disable the baseline reminder feature, and
if enabled to set the reminder interval.

Enable any connected SampleCams by selecting
their serial number from the dropdown list. Disable
the camera by selecting None.
Enable or disable whether the software warns you if
an error causes the camera to stop.
Click to enable automatic camera reinitialization
should an error occur. If you have a SampleCam it is
generally suggested that you keep this feature
enabled.
Set your Reflectance Standard Signal Threshold val-
ues. These determine at what percentage of the ini-
tial signal intensity the software will display a
warning during the Baseline process. This feature is
used to track lamp health, proper baseline pro-
cedure, and other parameters.
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Enable or disable theUniform Spectra Data Point
Spacing function. When enabled, saved spectra will
have their values set to a multiple of 1, 2 or 5. Stand-
ard Spacing sets the spacing equal or greater than
the smallest interval in the data, while Fine Spacing
sets the spacing to shorter than the smallest inter-
val.
For systems with multiple user accounts, enable or
disable sharing settings across all users. A folder to
store the settings file may be selected.
For systems with multiple user accounts, enable or
disable sharing settings across any users who have
slected this option. A folder to store the settings file
may be selected. This option is only available if Share
Settings with all users isn't enabled.
This feature allows the user to select a different
location for their Recipes folder, for example to a
shared network drive. This can be useful for syncing
recipes across multiple instruments in varying
locations.

Selecting Resetwill instruct the software to look in
the default location for the Recipe folder.
This feature is similar to the one above, only it allows
you to choose a different location for yourMaterials
folder.
Enable or disable whether the software prompts you
when it is ok to disconnect the instrument at soft-
ware shutdown.

Click to restore all settings to their default values.

Data Recording
TheData Recording tab contains controls for the various methods by which FILMeasuremay
automatically save collected data.

Enabling Automatically append results to filewill
instruct the software to create an excel file at a spe-
cified location in which a running tally ofmeasured
results are kept.

This feature is different from theHistory tab in that it only records results, not the spectra files as well. It
does not however have an upper limit on the number of spectra that can be recorded.
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Enabling Save once per spectrum will only append results when theMeasure button is pressed or a
saved spectra is opened in the software. Any changes in the recipe applied to existing spectra will not be
recorded. When this feature is disabled, any time a spectra is analyzed the result is entered into the file.

When Confirm before saving is turned on, the software will
provide a prompt before appending data to the excel file.

Continuous Measure: Measurement History Inclu-
sion controls which spectra are included in theHis-
tory tab when the Acquire > Measure Continuously
feature is used.

If the software is set to Prompt user to select History inclusion mode, a dialog will pop up prior to
beginning the continuous measure asking the user whether to save all measurements while measuring
continuously, or only the last measurement. The only last measurement feature can be useful on less
ideal surfaces (rough, non-uniform, etc.) where the user may have to search around the sample surface
for a spectrum capable of being analyzed.

Clicking Don't ask me this againwill disable the prompt, and the user will have to navigate back to this
menu to re-enable the feature.

The user can also select between having the software provide a prompt for which data to include in the
history file when using Acquire > Continuous Measure or to record all measurements to theHistory tab.

The Automatically archive History feature can be
used to have the software save a copy of the history
file whenever it hits 1000measurements.

The history files are saved in the following format (YYYY-MM-DD-X) where YYYY is the year, MM is the
month, DD is the day, and X is a serialized number based on howmany history files have been saved on
a given day.
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A value can be entered in megabytes for themaximum disk space to be allocated for the saved archives.
This will keep the software from using up all available hard disk space if the feature is enabled and then
forgotten. Should the software hit the allocated max, it will delete the oldest files in the selected folder
until enough space is available for the new history file.

Clicking Clear History after archive is writtenwill instruct the software to automatically clear the history
results after 1000measurements have been reached, and then begin counting towards the next group.
When it is disabled the history feature will work in the normal mode upon reaching 1000measurements
(newest measurement is added as Meas #1000, Meas #1 is deleted). It will write the next history file upon
reaching 1000measurements again, not each time theMeas# counter shows 1000.

Calibration

The F10-RT uses an integrated atomic-emission-line light source to update the wavelength calibration of
themeasurement system’s spectrometer. By allowing a system to self-calibrate, automatic wavelength
calibration provides significant compensation for calibration drift that could be caused by large
temperature changes or by moderatemechanical shock.

TheWavelength Calibration tab allows to user to choose how often they would like the system to
automatically calibrate the wavelength response of the system. Users can choose to calibrate with every
measurement, periodically, or whenever the software boots up. This action is performed in the
background and does not require any user input beyond setting the interval.

1.7.4 Acquire Menu
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Acquire > Acquire One Spectrum
This function collects a single spectrum and displays it on the screen. No analysis is performed until the
recipe is changed or the Analyze button is clicked.

Acquire > Acquire Continuously
This feature collects real-time data from the spectrometer. It is useful when searching for a specific
location to measure (for example, locating a more uniform area of the sample or one that exhibits
interference fringes). Stop continuous data acquisition by selecting Acquire Continously again.

Acquire > Measure Once
This feature collects a spectrum, analyzes it and displays it on the screen. This is the same as pressing the
Measure Button. For systems with the Sample Cam, this saves an image to the spectrum file created.

Acquire > Measure Continuously
This feature collects real-time spectrum data and analyzes it – similar to repeatedly pressing theMeasure
button. Ameasurement interval time can be set in the recipe using the Advanced options underneath
the Acquisition Settings tab. Stop continuous data acquisition by selectingMeasure Continously again,
or by pressing Ctrl+M.

Batch Acquire
The Batch functions allow you to act on groups of spectra, rather than each individual spectrum

Acquire > Batch > Acquire
This option allows you to acquire a pre-selected number of spectra. You can also choose to save the
batched spectra as they are acquired.
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Acquire > Batch > Measure
This option allows you to acquire and analyze a pre-selected number of spectra. You can also choose to
save the batched spectra as they are acquired.

Acquire > Batch > Analyze Spectra
This option allows the user to select multiple spectra for analysis by the current recipe. If there aremore
spectra to be analyzed than the software is set to Display, the analyzed spectra can easily be retrieved
from theHistory tab.

Acquire > Batch > Analyze All Spectra in Folder
This option will analyze every spectrum in a folder with the currently selected recipe. If there aremore
spectra to be analyzed than the software is set to Display, the analyzed spectra can easily be retrieved
from theHistory tab.

1.7.5 Help Menu

Diagnostics
The diagnostics window gives information regarding the data taken during the baseline. Reference and
background counts are shown (this is useful to see howmuch signal the system is getting; good
reference signals typically are between 2500-3500 counts). Data for the transmittance baseline can be
viewed by changing theMeasurement Sub-module.
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Help > Diagnostics shows the user information regarding the data taken during the baseline routine.

Help > About FILMeasure
Information about the hardware and software versions and the system serial number can be found here.
Please have this information available when calling Filmetrics for technical assistance.

Help>About FILMeasure... window

1.8 Taking a Baseline

The baselinemeasurement allows the FILMeasure software to take into account the response inherent
to the reflectancemeasurement hardware. It does this by first measuring the sample reflectance, then a
reflectance standard, then a background measurement, and finally by taking a “dark” reading. The light
source should be allowed to stabilize at least fiveminutes after being turned on before the baseline is
taken. When measuring films less than 1000 Å thick, the baseline should be periodically re-taken every
20-30minutes. For thicker films, a new baseline can be taken less often.
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Baselinemeasurements may be started two ways:

1. Select the Baseline button, which will guide the user through the baseline procedure, or

2. Select Setup>Standard/Background... from themenu bar for manual access to the baseline functions.

Step 1: Take a reflectance spectrum of the sample of interest. This is done by placing the sample face-
down on the sample stage and then clicking Take Sample Reflectancewhen prompted.

Step 2: Remove the sample from Step 1 and place the selected Reflectance Standard on the stage shiny
side down. Click Take Reflectance Standardwhen prompted. A selection of reflectance standards are
provided with the system. Which reflectance standard should be used depends on the sample to be
measured. In general BK7 can be used for films with a max reflectance of 0-12 percent reflectance, Si for
films from 12-60 percent reflectance, and Al for samples from 60-100 percent reflectance. The reference
material file that corresponds with the Reflectance Standard used should be selected from the drop
down list.

Step 3 Take a background scan with no sample on the stage (be sure to keep the light turned on so that
the light output remains stable). This step simultaneously takes a transmittance reference. Click Take
Backgroundwhen prompted.

Step 4 of the baselinemeasurement is to deflect the light away from both the bottom of the stage and
the stage arm on top. To do this, place the angled BK7 on the stage and click Take Darkwhen prompted.
If there is no angled BK7, hold either the flat BK7 or silicon reflectance standard, shiny side down, at a 10
to 80 degree angle, so that the light is deflected away.

After acquiring a baseline, the instrument is ready to begin making measurements. To verify that the
system is working properly, select Acquire One Spectrum from the Acquiremenu with the reflectance
standard in place. You should see the reflectance spectrum of the reflectance standard.
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2. Editing Film Recipes
The description of the nominal film structure, as well as themeasurement parameters, is specified in the
Edit Recipe dialog box. Hundreds of different film structures and their measurement specifications may
be saved.

The Edit Recipe dialog box is accessed with the Edit Recipe... button on theMeasure Tab. The Edit
Recipe dialog box lists an initial guess at the specifications of the film structure to bemeasured. These
specifications include the number of films in the structure, the layer order of the films in the structure,
the specifications of individual films (thickness and index), and the film parameters to bemeasured.

2.1 Adding, Changing, or Deleting a Structure

When the Edit Recipe dialog box is opened, it shows the stored specifications of the structure selected
from the Recipe Name: list, along with any changes made since the recipe was loaded. Changes to the
structure selected can be permanently stored by making the desired changes and then clicking on Save.
Changes can also be stored as a new recipe by clicking on Save As. A structuremay be deleted (removed
from the Recipe Name: list) by clicking on theDelete button.

2.2 Spectrum Analysis

The following section describes the Edit Recipe dialog when used in Spectramode. For Thickness, n, k
and rmode, continue on to Film Stack.

Min/Max
Local minima and maxima can be found by inputting values in the proper dialog boxes. The Region refers
to the label that will be appended to the dataset as defined by the values entered in recipe.Wavelength
Limits Start and End are used to set the wavelength range over which to find theminima and maxima.

To set minimum and maximum reflectance criteria, values can be entered into theMin R andMax R
boxes (1 = 100% reflectance if Y axis as percent is disabled underneath Graph Limits). If there isn't a
minima or maxima within the range selected, Hard Limits can be enabled to show the highest or lowest
point within the defined range.

Selecting HC Correctionwill account for the effect of a hardcoat on the spectrum if a film is present. The
region will not be analyzed until the corresponding Active checkbox is selected. Multiple sections can be
defined by pressing the + and - buttons to the left of the dialog box.

Average Reflectance
When analyzing spectra, it is useful to know the average reflectance at certain wavelength ranges. The
Average Reflectance tab of the Edit Recipewindow allows the user to define areas for analyzing average
reflectance. Desired wavelength and reflectance ranges entered in the recipe will show up as labeled
boxes with solid outlines in themain graph window.
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Results that fall outside these windows will trigger an alarm to alert the user that themeasurements are
outside of the desired range. The region will not be analyzed until the corresponding Active checkbox is

selected. Additional sections can be defined by pressing the button to the left of the dialog box, and

unwanted sections can be removed by pressing the .

The software is also capable of calculating the Luminous Reflectance or transmittance (if available) of a
sample as well as it's yellowness index (YI D1925) andWeighted Solar UV (SUV) values.

Luminous reflectance is a weighted reflectance average, calculated using the product of themeasured
spectrum, a D65 irradiance, and the human eye efficiency as calculated in ISO 13666:2012.

Yellowness index is a measure of how yellow a material is, and is calculated using the product of the
measured spectrum, illuminant C using the 2 degree observer, and the following equation:

If other values are selected for illuminant or observer in the Setup > Displaymenu, the software will
ignore those values for the purpose of calculating the yellowness index.

TheWeighted Solar UV values represent the reflectance (or transmittance) values across theUV A (315-
380 nm), UV B (280-315 nm), or UV AB (280-380 nm)wavelength ranges. These values are calculated per
the definition provided in ISO 13666:2012.

Spectrum Pre-processing
This function performs wavelength-dependent boxcar averaging on themeasured spectra. This can
improve signal-to-noise levels and can filter out oscillations that correspond to optical thicknesses
(defined as indexmultiplied by thickness) equal or greater than the specified value. This value should be
lowered to increase smoothing, and raised to decrease smoothing. To eliminate smoothing, a very high
value (for example, 1000 um) should be entered.
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2.3 Film Stack

The Film Stack tab is used to define the film structure and desired measurement units, as well as the
starting guesses and constraints for thickness, n, and k. This is also where you determine your analysis
method; Grid, FFT, orNone, as well as any Nonuniformity that may be present in the sample. The [+]
and [-] below Composition, Thickness and Nonuniformity can be used to expand or hide solving
options.

2.3.1 Setting Up a Film Stack
When measuring a layer, the parameters (thickness, n, and k) of the known films (including the incident
medium and substrate)must be entered into the proper fields in the Edit Recipe dialog box, as well as
initial guesses for the values to bemeasured. The refractive index (n) and extinction coefficient (k) values
for common materials can be selected from the drop-down menus on the right-hand side of the listed
materials, or by left-clicking on thematerial and using the Search function. Note that if a generic index is
selected, the software will instead prompt for a new index value.

If a material is being measured is not present in thematerial library there are three possible approaches
to complete the recipe:

a) Choose a material in the library that is similar.
b) If thematerial is transparent (an insulator), select “Enter Refractive Index Value” from the
material list and enter a value for the refractive index (n will automatically be varied by FILMeasure
to account for dispersion effects, with the entered value being n at 632.8 nm).
c) Create a newmaterial file using the Edit > Material Library… dialog box. Enter the refractive index
values for n and k as a function of wavelength and save the files so that they may be selected as in
the recipe. See Creating and Editing n and k Files for more information.
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2.3.2 Choosing the Films to be Measured
To measure a film's thickness, mark the check box on the right-hand side of the Thickness field under the
Film Stack tab in the Edit Recipe dialog box. When no boxes are checked, the theoretical spectrum for
the specified layer stack and thicknesses entered in the recipe will be displayed.

As with most measurements, the uncertainty of themeasured data increases as the number of
simultaneously measured values increases. Thus it is best to provide as much information about the film
structure as possible.

2.3.3 Constraints
By setting constraints, the user can limit the possible values of themeasured film properties. The
constraints are set in conjunction with the values entered in the Range dialog box for Thickness. For
example, if the initial guess of themeasured thickness of a film is 100 nm and the thickness constraint is
set at 50%, FILMeasure will only consider possible thicknesses in the range 50 nm to 150 nm.

Measurement results that are equal or nearly equal to themin or max thickness limit will bemarked as
invalid, unless theminimum GOF limit is 0 (using the above example, a result of 50 nm would show as
invalid). This feature is intended to make sure that the user is alerted to results that may not be accurate
as the correct solution is not available in the currently provided range. To clear the invalid result, simply
use a larger constraint or change the nominal thickness value.

The constraints for n and k are set using the n and k dialog boxes under Composition. These boxes are
only visible when the Thickness or Composition options are expanded.

You can select between constraining by a percent of the thickness guess, or by absolute thickness units
by clicking on the % or measurement unit above the constraints dialog box. Constraining the
measurement range can speed up analysis and can also help exclude non-physical solutions.

2.3.4 Units
TheUnits drop down menu allows the user to easily switch between their desired measurement unit,
ranging from angstroms up to inches. The software will automatically convert between units when a
different unit is selected (e.g. 1micron will be converted to 1000 nm).

The Custom Unit function allows you to create your own custom unit for measurements if themetric
you'd like isn't already available in the drop-down list.
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The Edit Custom Units dialog box.

To determine the correct coefficient to use, you must first know the relationship between your unit and
nanometers. For example, if your units aremg/ft2 and it's been determined that 1mg/ft2works out to a
film thickness of 150 nm, then you would calculate your coefficient as follows, where X is the coefficient.

Custom units can be saved as part of the Recipe file, and only one custom unit can be saved per recipe.
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2.3.5 Composition
When measuring the n and k of a film, the general dependence of these values upon wavelength must be
specified. This dependence is determined by the type ofmaterial to bemeasured. For example,
insulators, semiconductors, and metals all have a unique type of n and k wavelength dependence.

Dozens ofmodels for these different dependencies have been proposed and used over the years.
FILMeasure uses a few of themost versatile and accepted models. For insulators the Cauchy model is
used, for semiconductors either the Amorphous or Bridge-Lorentzian model, and for metals the Drude
model.

There are also a number of special-purposemodels for specific applications. Thesemodels and starting
coefficients values are selected automatically when a material is chosen from theMaterial lists in the Edit
Recipe dialog box. Other models may also be specified by selecting them from the nk Model drop-down
menu under the Composition tab which is accessed by right clicking on theMeas checkbox when solving
for optical constants is enabled.

2.3.6 Grid Search for Thickness
There are a number ofmethods that FILMeasure can use to determine thickness. Each is a different
trade-off between speed, accuracy, and robustness (i.e., the ability to find the best solution among many
that are nearly as good). Because thickness can vary over many orders ofmagnitude and many near-
solutions may exist, it is often best to use a very robust method to get close to the best solution, and
then let a more accuratemethod take over.

One very robust method is theGridmethod, which can be activated by selecting theGrid option in the
Refine via drop-down menu. TheGridmethod searches the entire allowed thickness range (as defined
by the initial guess and the constraints) to find the best initial thickness. However, on some very complex
multilayer spectra, it is possible for the Grid method to give the wrong answer. In such cases it is best to
use the Fourier Transform(FFT)method to determine initial thicknesses, or to provide them manually.

2.3.7 Fourier Search for Thickness
The FFT option in the Refine via drop-down list is an alternative option to let FILMeasure choose an
initial thickness for analysis. The Fourier Transform method analyzes the oscillations present in the
spectrum and determines the film thicknesses based on the periodicity of those oscillations. It is
generally somewhat less robust than theGridmethod, but is better at finding the correct thickness in
cases where the shape of the initial theoretical spectrum is different than themeasured data (i.e., the
reflectance spectrum is non-ideal in someway) or occasionally in cases where there is more than one film
thickness is being measured.
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2.3.8 Nonuniformity

The Edit Recipe > Film Stack tab with the Nonuniformity option expanded.

Selecting this option enables modeling of thickness nonuniformity within themeasurement spot. An
initial guess forNonuniformitymust first bemade, and then solving can be enabled or disabled by
toggling the Vary box. If solving is not enabled, the software will assume the value provided for
nonuniformity.

Note: Solving for nonuniformity can greatly increase solving time.
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2.3.9 Search

The Search Materials dialog box is accessible by left-clicking on a material name in the Edit Recipe > Film
Stack tab, or by selecting Search... from thematerial selection drop-down list.

Note: When clicking on a generic index file, the software will instead provide you with a dialog to enter a
new index value.

This feature allows the user to search for materials by using either thematerial name, or a keyword for a
certain class ofmaterials. The search function will also show a briefDescription of thematerial selected,
as well as any Synonyms or Keywords related to thematerial file. When files have a Synonym, that
means they are referencing the samematerial file under different names. For example, if Silicon is
selected the file that will be shown in the Film Stack is Si, not Silicon, as that is the file both names are
referencing. The Similar Materials box will list any materials that may have similar optical properties.

2.4 Analysis Options

Correct setting of the following options will help ensure accuratemeasurements. Many of the options
are set automatically when film information is supplied in the Edit Recipe dialog box, and all of them can
be saved so that subsequent measurements can bemade as quickly and easily as possible. If Robust
(Adaptive; Thickness Only) or FFT (Thickness Only) is checked (Requires UPG-RT-to-Thickness), only the
Data Selection settings will be accessible.
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2.4.1 Data Selection

Wavelength Range
This sets the wavelength range that is to be analyzed. It may be set as either the entire range displayed
on the graph or a fixed range as defined by the user. Wavelength rangemay also be changed by clicking
and dragging the ends of the gray bar near the bottom of the graph area in themain FILMeasure
window. Moving the bar will cause the software to reanalyze the data in the newly selected wavelength
range.

Smoothing
This function performs wavelength-dependent boxcar averaging on themeasured spectra. This can
improve signal-to-noise levels and can filter out oscillations that correspond to optical thicknesses
(defined as thickness * refractive index) equal or greater than the specified value. This value should be
lowered to increase smoothing, and raised to decrease smoothing. To eliminate smoothing, enter a very
high value (1000 μm, for example).

Source Data
If more than one data set is present, this option tells the software whether to analyze the 0 degree
reflectance data, 0 degree transmittance data, 70 degree reflectance data, or some combination of the
three.

Note: While every Filmetrics system is capable of opening and analyzing spectra with 70 degree
reflectance data, only the F10-RTA is capable of collecting this data.

2.4.2 Enable FFT (Thickness Only)
The FFT (thickness only) solver is one of three analysis methods available in the FILMeasure software
with the UPG-RT-to-Thickness option.

http://filmetrics.com/thicknessmeasurement/f10-rt
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This solver is best suited for films greater than 250 nm thick, as well as multi-layered films. It is also an
effective option when the index of refraction of the film isn't well known. While this feature is selected
there will be fewer options under the Analysis Options tab. You cannot solve for index, roughness, or
nonuniformity with the FFT (thickness only) solver enabled. More information on the solver can be
found here.

2.4.3 Enable Robust (Adaptive; Thickness Only)
The Robust (adaptive; thickness only) solver is the second of three analysis methods available within
FILMeasure with the UPG-RT-to-Thickness option. It is best suited for measuring the thickness of single-
layer films greater than 150 nm thick.

This method can oftentimes successfully measure films when the data is affected by non-ideal properties,
such as thickness nonuniformity, grading, and birefringence. Much like the FFT (thickness only) solver,
enabling Robust (adaptive; thickness only) will limit the options available in the Analysis Options tab.
You also cannot solve for roughness, nonuniformity or index with the Robust (adaptive; thickness only)
solver enabled.

2.4.4 Exact Spectrum Matching
The Exact Spectrum Matching is the third of three analysis methods available in FILMeasure with the
UPG-RT-to-Thickness and UPG-Thickness-to-n&k option. This solver can be used to measure thickness,
thickness nonuniformity, and roughness of single and multilayer films, and can additionally solve for
index.

Unmodeled Backside Reflections
When measuring films on transparent substrates, reflectance off of the backside of the substratemay
occur. Selecting Compensate for: Unmodeled backside reflections allows the software to shift the
intensity of the calculated reflectance curve to account for the additional light. This feature should not be
used when measuring very thin films (< 100 nm).

Tilted Sample/Lost Light
Samples with non-coplanar surfaces scatter some of the light away from the collection optics. This option
automatically compensates for the light lost due to nonplanarity.

Lock Identical Layers
Samples comprised of repeating layers can bemore accurately measured by activating this option. By
activating these options, all properties of any layers that initially have the samematerial or thickness are
locked together.

2.4.5 Analysis Options: Advanced
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Advanced Analysis Options for Spectrum Matching.

Convergence Criteria
This sets theminimum GOF between themeasured and calculated spectra that is attained before the
measurement routines consider the solution final. In most cases a value of 0.999 is sufficient. For cases
where the desired GOF is not attainable, the value in theMaximum Iterations field limits the number of
iterations performed by the analysis routine.

Solver Cycles
This option will enablemultiple solver cycles, with the number of cycles being defined by the number
entered in the text box. When using this option, the software will run through themodel for a solution
once, and then try again starting from the solution previously found. This can help find the best solution
amongst a number of near-best solutions, which can be the case when solving for a large number of
parameters (several thicknesses and/or refractive index). A greater number of cycles will lead to a longer
solving time.

Display Details
This feature controls the wavelength at which n and k are displayed in theMeasurement Details portion
of themain screen. These values are only displayed if solving for n or k is selected in the Film Stack tab.
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Advanced Analysis Options for FFT Analysis.

FFT Analysis Window
When the FFT solver is selected, the advanced options give you access to various settings to help
optimize analysis performance. When Optimize Position is selected, the solver will check for the best
possible GOF value in different areas across the spectrum in a wavelength range defined by the entered
window size. For example, if a window size of 200 nm is selected, the solver will look at six different 200
nm sections of the spectrum, and then select the range the provides the best GOF.

IfOptimize Size is selected, the solver will instead begin with a minimum window size as defined by the
user. It will then start at the center of the analysis range, and then extend equally in both directions six
times to find the best GOF. When Optimize Position and Size is selected, the software does both
functions, resulting in measuring thirty-one different combinations of location and analysis range.

The FFT Total Thickness is used when only the total thickness of a multi-layer stack is of interest. In these
cases the user would define a single layer recipe, and enable the total thickness option. The solver will
then perform a special analysis and look for the peak that corresponds with the thickest measured value
within the current parametrs of the recipe, checked against a minimum peak height. This value is used to
insure that only a true thickness peak, and not a side lobe of another peak is identified as the correct
result.

The FFT Window Function allows you to select between four different window functions to apply to the
FFT analysis. By default this feature will be disabled (None). Descriptions of different mathematical
functions can be found here

https://en.wikipedia.org/wiki/Window_function
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The FFT Scaling Factor is used for non-ideal samples, where theremaybe an alignment in the x-axis of the
FFT plot, but not the y-axis. This may occur for many reasons such as a very rough, non-uniform, or in
some other way non-ideal film. By adjusting the scaling factor, you can increase or decrease the
amplitude of themodelled fit to improve your GOF values.

2.5 Alarms

Minimum Valid GOF
Constraining theMinimum Valid GOF will excludemeasurements where the calculated GOF does not
reach the specified limit. Awarning or “Invalid” result will appear if the GOF constraint is not met. Specify
0 to have all solutions reported.

Activate Alarms
When Activate Alarms is selected, an alarm will trigger if themeasured thickness of the sample is outside
the specified Thickness Limits. Measurements that fall within the thickness limits will be indicated by a
green box surrounding themeasurement result in theMeasurement Status window under theMeasure
Tab. Ameasurement that falls outside of the selected limits will instead show a red box surrounding the
measurement result.

Thickness Limits
Setting theminimum and maximum allowable thickness limits will trigger an alarm if themeasured
thickness is outside the limits when Activate Alarms is selected.
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2.6 Acquisition Settings

This menu lets the user controlMeasurement Timing, Spectrometer Type (on EXR and UVX systems),
and Advanced Acquisition Settings.

2.6.1 Measurement Timing

Use Recommended Sampling Time
Selecting this option uses the sampling time that has been automatically calculated by the software
during the baseline procedure. The displayed value is the total sampling time and not necessarily the
integration time. To see the integration time and number of integration cycles go to theHelp >
Diagnosticsmenu.

Use Maximum Sampling Time
Users can set a maximum sampling time by selecting this option. By increasing sampling time the user
may see a decrease in signal noise, but at the trade-off of a longer acquisition time. Integration time and
cycles will still be determined by the FILMeasure software.
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Use Manually Set Parameters
Users can set both the integration time per acquisition cycle and the number of integration cycles over
which to average. When using this option, the total sampling time is equal to the integration time
multiplied by the number of integration cycles.

To set the integration timemanually, set the sample on the stage and select Setup>Raw Signal… If the
proper integration time is unknown, an initial value of 40ms is a good starting guess. The vertical scale of
the spectrum extends from zero to 4000. Thus, a good working level is when the peak height of the
sample being measured, or the reflectance standard, whichever is greater, is 3000-3500 counts. If the
maximum signal is too low, increase the integration time. Too large an integration timewill result in
excessive dark current, so it is sometimes necessary to accept a smaller signal level to limit the dark
current.

Notes:
1. If the reference measurement saturates, the software will display a detector saturation error.
Analyzing a saturated spectrum will result in spurious final measurements. Take a new baseline
with a lowered integration time.
2. If the integration time is changed, it will be necessary to perform the baseline procedure, or re-
acquire the reflectance standard and background scans.

2.6.2 Spectrometer Type
EXR and UVX systems have two spectrometers(VIS-NIR and UV/VIS-NIR respectively). Here the user can
choose to use only one or both spectrometers.

2.6.3 Advanced Acquisition Settings

Store Baseline settings in Recipe
This option allows the user to save the selected Optics Configuration, Baseline Name, and Reflectance
Standard used with each individual recipe.
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Continuous Measure Settings
This option allows the user to set an interval, in seconds, between measurements when using the
Measure > Continuous Measure command from the Acquire Menu. By default this is set to 0.
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3. Making Measurements
Accuratemeasurements with the F10-RT rely on using the proper measurement setup. The basic steps
for any F10-RT measurement are:

1) Selecting and/or editing the Film Stack to bemeasured.
2) Taking a Baselinemeasurement.
3) Clicking on theMeasure button to acquire and analyze themeasured spectrum.

Each example belowwill take you through this sequence of steps. In each example it is assumed that the
hardware has been set up as described in theQuick Start Guide, and that you have first read through
the Software Overview section to familiarize yourself with the basic controls.

TheMeasurement Assumptions, Hints for Improved Accuracy, and Troubleshooting sections describe
techniques that should be followed for themost accuratemeasurements.

Displaying the Measurement Spot Using the SampleCam
On systems with a SampleCam, FILMeasure can add a measurement spot with varying opacity to the live
image displayed in the software. This is meant to aid users in locating themeasurement spot on the
sample. This feature is especially helpful on samples that don't scatter light, SiO2 on Si for example,
where it can be hard to determine themeasurement spot with the naked eye.

Enabling the SampleCam
The first step in displaying themeasurement spot is to enable the SampleCam in the software. With the
SampleCam plugged into the computer and FILMeasure launched, go to the Setup Menu and select
Options. In theOptions dialog box there will be a drop down list, showing any SampleCams that are
attached to the system. Select the serial number matching the SampleCam you'd like to use, and then
click OK.

You should now see a vertical bar with an arrow pointing to the right on the left side of themain graph in
FILMeasure. Click on this bar to expand the SampleCam window. You will be able to choose between the
Live Video tab, which is a live stream from the SampleCam, or the Still Image tab, which displays the
image that was captured when the selected spectrum was taken. If there is no image associated with a
spectrum, FILMeasurewill instead display a blank gray box.

Setting the Measurement Spot
Once the camera has been enabled and you are looking at the Live Video tab, click on the Settings…
button to access the Video Settings. From this dialog box you can begin the process to display the
measurement spot by clicking on Set Spot Location.
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When you click on Set Spot Location, the software will prompt you to confirm that your fibers are
connected correctly. If the fiber you are using has an end labeled light source, you'll want to disconnect
that end of the fiber from the light source and connect the other, unlabelled leg into the light source
input. For all other fibers, you can leave the system as normally configured. You will then want to place a
flat, uniform, and diffuse sample underneath the light path, a blank sheet of paper is a good example.
You can then click theOK button to set themeasurement spot.

Displaying the Measurement Spot
Once you've clicked OK, you will be brought back to the Video Settings dialog box. Make sure that the
check box next to Show Measurement Spot using Opacity of: has been selected. Opacity of the
measurement spot is determined by the value entered into the text field on the right, with 0% being
completely transparent, and 100% being completely opaque. It is up to the user to determine what level
of opacity they would prefer. Click OK to save any changes.

At this point, themeasurement spot should be fully calibrated and ready to use.

Before You Make Measurements
Beforemaking measurements, it is important to understand both reflectance and transmittance and
how samplematerial and placement affect the acquired spectra.
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Scattering and Absorption
Generally speaking, light that impinges on a sample can be reflected (R), transmitted (T), absorbed (A), or
scattered (S). This can be written as R + T + A + S = 1. (Scattering is defined here as light that is reflected or
transmitted in such a direction that it is not collected by the reflectance or transmittance detectors. It is
usually caused by surface or interface roughness.) For a sample that has no absorption or scattering (i.e.
A = 0 and S = 0), R + T = 1.

Therefore, if R + T < 1 then the sample is most likely absorbing or scattering light. The easiest way to
confirm scattering is to notice if themeasurement spot can be seen; in general, scattering by roughness
less than 5 nm is difficult to detect by eye, whereas scattering by roughness greater than 30 nm makes
themeasurement spot appear almost white.

Sample Placement
If a sample has A = 0 and S = 0, so that R + T = 1, then the orientation of the sample (i.e., which side is up)
is unimportant. This is helpful if the user doesn’t wish to set the sample face-down on the stage. For
cases where the sample is face down, the supplied lens paper (p/n 500-0029) may be used between the
stage and sample. Caremust be used so that the paper is flat and so that the hole is lined up so that the
stage aperture is completely unobstructed (adhesive tape is often useful for positioning the lens paper.)

3.1 Measuring Reflectance and Transmittance

The example belowwill take you through this sequence of steps. It is assumed that the hardware has
been set up as described in theQuick Start Guide, and that you have first read through Software
Overview to familiarize yourself with the basic controls.

Example #1: Average Reflectance/Transmittance and Min/Max Analysis.

Example: Average Reflectance/Transmittance and Min/Max Analysis
In this example we use the VIS-AR Standard to demonstrate how to make reflectancemeasurements.
These same techniques can be used for transmittancemeasurements by enabling the transmittance
spectrometer under Acquisition Settings, and clicking the T radio button under Spectrum Type in the
Average Reflectance orMin/Max tab.

Step 1: Select the Recipe.
With the Spectra tab selected in themain FILMeasure window, choose the recipe to bemeasured, in this
case “AR Standard”, from the Recipe list box on themain screen. If the recipe to bemeasured does not
exist, a new recipemust be defined.

http://filmetrics.com/accessories/general-accessories


5 4

Step 2: Edit the Recipe.

Example Edit Recipe...>Average Reflectance window for measuring sample reflectance.

If there isn't already an existing recipe, you must first edit the recipe to match your desired analysis
values. Click the Edit Recipe button to open the dialog box. Under the Average Reflectance tab you can
tell the software to measure the average reflectance or transmittance (using the R or T radio button) of a
sample across a set wavelength range, and report whether that value falls within a minimum and
maximum value you provide. In this example we expect the sample to have an average reflectance
between 1% and 3% across the 410-460 nm wavelength range. Click on the checkbox at the right to
activate the average reflectance analysis function.

Example Edit Recipe...>Min/Max window for measuring minima and maxima.
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TheMin/Max tab can be used to locate reflectance and transmittanceminima and maxima in specified
wavelength ranges. The functionality remains similar to the Average Reflectance tab, with the addition of
theHard Limits box. By enabling hard limits, the software will only report theminima or maxima in the
specified wavelength range. This is useful in cases where there is no inflection point within the defined
wavelength range. Don't forget to mark theMin/Max analysis as active on the right side.

Under the Acquisition Settings tab, make sure to select the appropriate input under theMeasurement
Type options for the type of data you'd like to collect. As the VIS-AR standard is opaque, we'll only need
the reflectancemode enabled. Click OK to save the changes to the recipe.

For further details on creating your own recipes, see the Editing Film Recipes section.

Step 3: Take a Baseline Measurement.
Take a baselinemeasurement by first clicking on the Baseline button on themain screen. A dialog box
will appear to step you through the process. Follow the steps on screen, and be sure to match the
referencematerial selected with the reflectance standard that will be used. For this example use the BK7
reflectance standard.

Step 4: Make the Measurement.
Make themeasurement by placing your sample, coated side up, on the stage, and pressing theMeasure
button. FILMeasure will then acquire the reflectance spectrum, and analyze it as defined by the recipe.
There will be labeled boxes on the screen, solid for average reflectance and dashed for min/max, which
indicate where the expected average reflectance and minima or maxima should fall.

There will also be a solid horizontal line representing themeasured average reflectance, and a round
marker to represent themeasured minima or maxima. Thosemarks will be green if the values fell within
the expected parameters, and red if they did not. The software will also indicate whether the
measurement was Good, meaning all values were within the provided ranges, or Bad if one or more
values fell outside of their defined range.
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3.2 Making Measurements with Thickness-Enabled Systems

The example belowwill take you through this sequence of steps. In each example it is assumed that the
hardware has been set up as described in theQuick Start Guide, and that you have first read through
Software Overview to familiarize yourself with the basic controls.

The Before You Make Measurements,Measurement Assumptions, Hints for Improved Accuracy, and
Troubleshooting sections describe techniques that should be followed for themost accurate
measurements.

Example #1: Measuring the Hardcoat Thickness Standard

Example: Measuring the Hardcoat Thickness Standard
For this example wewill demonstrate themeasurement of the TS-Hardcoat-Trans thickness standard
with the UPG-RT-to-Thickness for the F10-RT.

Step 1: Select the Recipe
With the Thickness, n, k, r tab selected in themain FILMeasure window choose the recipe to be
measured, in this case “HC Standard on Acrylic - Trans”, from the Recipe list box on themain screen. If
the film stack to bemeasured does not exist, a new recipemust be defined
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Step 2: Edit the Film Stack
To edit the film stack, click the Edit Recipe... button to open the dialog box. Check to see that the film
stack matches that of the actual sample. If not, different films can be selected using either the drop down
menu next to thematerial or the Search function. This is also where you can enter a starting guess for
thickness as well as the desired constraint range.

Example Edit Recipe>Film Stackwindow for measuring the thickness of the hardcoat standard.

For this example, we'll use 6microns as theNominal thickness, with a constraint range of 75%. Make
sure that the HC Standard - 2 layer thickness is being solved for by clicking the checkbox underMeas. The
second layer should be Acrylic - 2 with a thickness of 2000 μm, or 2mm, with Air as the substrate. Do not
enable solving for the Acrylic - 2 layer. This lets the software know that there is a finitely thick layer, so
that it will accurately account for back reflections. Click OK to save the changes to the recipe.

To learn more about creating recipes, see Editing Film Recipes.

Step 3: Take a Baseline Measurement
Take a baselinemeasurement by first clicking on the Baseline button on themain screen. A dialog box
will appear to step you through the process. Follow the steps on screen, and be sure to match the
referencematerial selected with the reflectance standard that will be used. For this example use the
ALREF reflectance standard.
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Step 4: Make the Measurement
Make themeasurement by placing the thickness standard coated side down on the stage and clicking on
theMeasure button. FILMeasure will then acquire the reflectance and transmittance spectra and
calculate the corresponding thickness. If themeasurement was successful, themaxima of the calculated
FFT intensity (the red line on the lower graph) will coincide in thickness with themaxima of themeasured
FFT intensity (the blue line on the lower graph). You can select between analyzing the reflectance or
transmittance data underneath the Edit Recipe > Analysis Options tab.

Measured and calculated reflectance spectra when measuring the hardcoat-on-acrylic thickness standard.

If the calculated (red) and measured (blue) intensity peaks do not coincide, then themeasurement was
not successful. There are several possible causes of an unsuccessful measurement. Themost common
for this type ofmeasurement are described in Cases #1, #2, and #3 in the Troubleshooting section.

3.3 Measuring Thickness and Constants

For users who have n and k enabled software, certain modifications to the standard FILMeasure
software have been made to allow users to accurately determine the index of refraction and extinction
coefficient of a film. SeeMeasuring with Thickness, n, and k Measurement Upgrade for more
information on the softwaremodifications.

For n and k-enabled users, n and k can bemeasured by checking the appropriate box underneath the
expanded Composition option in the Edit Recipe… dialog box. When an optical constant is selected for
measurement, Robust (Adaptive; Thickness Only) and FFT (Thickness Only) cannot be selected.
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In general, thickness values can bemeasured independently if the n and k of the layer are specified.
However, unless the thickness is known within better than a nanometer, n and k cannot bemeasured
without also measuring thickness. Also, unless thematerial is a dielectric (k=0), n and kmust be
measured together.

As with most measurements, the uncertainty of themeasured data increases as the number of
simultaneously measured values increases. This is especially true here, where it is possible for changes in
thickness, n, and k to affect themeasured spectrum in similar ways. Thus it is best to provide as much
information about the film stack as possible.

Example #1: Thickness and Optical Constants of Films on Transparent Substrates

Example: Thickness and Optical Constants of Films on Transparent Substrates
For this example wewill demonstrate themeasurement of optical constants of a TiO2 film on BK7with
the UPG-Thickness-to-n&k for the F10-RT.

Step 1: Select the Recipe
With the Thickness, n, k, r tab selected in themain FILMeasure window choose the recipe to be
measured, in this case “TiO2 on BK7”, from the Recipe list box on themain screen. If the film stack to be
measured does not exist, a new recipemust be defined.

Example Edit Recipe…>Film Stackwindow for measuring the thickness, n, and k of films on a thick transparent
substrate.

Step 2: Edit the Film Stack
To edit the film stack, click the Edit Recipe... button to open the dialog box. Check to see that the film
stack matches that of the actual sample. If not, different films can be selected using either the drop down
menu next to thematerial or the Search function. This is also where you can enter a starting guess for
thickness as well as the desired constraint range.
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For this example, we'll use TiO2 as our layer 1, BK7 as our layer 2, and Air as our substrate. As noted in
the introduction themore data we can provide to the software themore accurate the final result. In this
case, we know the substrate to be a 1mm thick piece of glass, so wewill fix the thickness of layer 2 at
1000000 nm, or 1mm. As the thickness of the TiO2 film has not yet been determined, we'll use a starting
guess of 500 nm with a constraint range of 75%.

If the Composition section is not already expanded, press the + button to display the n and k solving
options. These dialog boxes refer to the constraints being placed on the solver when it comes to solving
for optical constants. Thematerial file selected for that layer acts as a starting guess. For this example
we'll use a constraint of 2 for n and 1 for k. We'll also want to select the correct model for optical
constants solving, which is accessed by right clicking on theMeas box next to the n and k constraints.
Select the Amorphousmodel. For more information on the different models, see here. To enable solving
for index click on theMeas button.

It is important that no compensations are being made by the software, so make sure that neither
Unmodeled Backside Reflections nor Tilted Sample/Lost Light options are checked under the Analysis
Options tab. Click OK to save the changes to the recipe.

To learn more about creating recipes see Editing Film Recipes.

Step 3: Take a Baseline Measurement
Take a baselinemeasurement by first clicking on the Baseline button on themain screen. A dialog box
will appear to step you through the process. Follow the steps on screen, and be sure to match the
referencematerial selected with the reflectance standard that will be used. For this example use the Si
reflectance standard.

Step 4: Make the Measurement
Make themeasurement by placing your sample on the stage and click on theMeasure button.
FILMeasure will then acquire the reflectance and transmittance spectra and calculate the corresponding
thickness and optical constants. If themeasurement was successful, theminima and themaxima of the
calculated reflectance (the red line on the graph) will coincide in wavelength with theminima and the
maxima of themeasured reflectance (the blue line on the graph).

If themeasured and calculated spectra do not fall on top of each other, the resulting thickness, n, and k
values are incorrect. If themismatch between measured data and calculation is only slight, the results
reported will only be off by a small amount. If themeasured and calculated spectra match, but the
results are implausible theremay be a problem with the sample positioning and light collection. Causes
and corrective actions to improve themeasurements are listed in Cases #4 and #5 in the
Troubleshooting section.
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Measured and calculated reflectance spectra when measuring the thickness, n, and k of TiO2 on BK7 glass.

3.4 Measurement Assumptions

The following assumptions must be valid if accuratemeasurements are to bemadewith the F10-RT:

1. Every film present in the structure is specified in the Edit Recipe dialog box. This includes every film
present in the sample including so-called adhesion films, oxide films (unless they are less than 20 Å thick),
and films on the bottom surface of the substrate if the substrate is transparent.

2. If the film is Nonuniform, it has been accounted for in the recipe.

3. The light source has been allowed to warm up for at least 5minutes if measuring thickness of films
greater than 250nm, or 15minutes if measuring thickness of films less than 250nm, refractive index, or
reflectance.

In addition, the following assumptions aremade if optical constants and/or very thin films (<500 Å) are to
bemeasured:

4. If any grading is present (i.e. the refractive index and extinction coefficient are constant as a function of
depth and constant over the entire spot being measured), it has been accounted for in the recipe.

5. The sample is flat. (The vacuum port may help in this case when samples are warped.)
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6. No changes to themeasurement system (such as fibers being moved) or light source have occurred
since the acquisition of themost recent baseline.

7. No significant changes in room temperature (> 5 degrees F) have occurred since acquisition of themost
recent baseline.

If any of the above assumptions are not true, it may still be possible to make a measurement, but
accuracy may be degraded.

3.5 Hints for Improved Accuracy

This section contains various tips to help improve accuracy in your measurements.

Roughness.

Restricting the wavelength range of the analyzed reflection spectra.

Measuring thickness when the approximate thickness is not well known.

3.5.1 Roughness
Slight amounts of surface or interface roughness that may be present can decrease theGOF value of a
measurement. Entering a value or solving for roughness can partially account for this roughness so that
a better GOFmay be achieved. Generally, roughness is only present when the sample surface looks hazy
at themeasurement spot. The fact that haze can be seen means that there is scattered light. (A perfectly
smooth surface will scatter no light, and thus themeasured spot will not be visible.) Usually roughness
less than 2.5 nm will not be visible, while roughness greater than about 25 nm will be extremely hazy.

FILMeasure assumes a Gaussian distribution of the surface height irregularities about themean and it
assumes that the roughness is small compared to the wavelength. FILMeasure reports the rms
roughness value.

3.5.2 Restricting the wavelength range of the analyzed reflectance spectrum
Occasionally spectra from measured films are adversely affected by factors such as absorbing dyes,
birefringence, or nonuniformity – all of which are difficult to model properly. It is often still possible to
make accurate thickness measurements of these films by analyzing only unaffected portions of the
spectra. The portion of the spectrum that is used to calculate film properties is determined in the recipe
underneath the Analysis Options tab.

You can also adjust the wavelength analysis range in themain FILMeasure window using the gray bar at
the bottom of the graph. Click and drag either end of the bar to a new position on the x-axis to adjust the
analysis range.
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Example of a non-ideal film (spectrum with no oscillations at lower wavelengths) that requires reduced wavelength
range for accurate measurement.
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Example of a reduced wavelength range for measuring thickness of non-ideal films.

3.5.3 Measuring thickness when the approximate thickness is not well known
Unless otherwise specified, FILMeasure will determine a film’s thickness by finding the best answer within
about 1000 Å of the initial (user supplied) value. If the approximate thickness of the film is not known to
better than about 1000 Å, then theGridmethod or the Fourier Transformmethod of determining
approximate thickness may be applied. See Editing Film Structures for more details.

3.6 Troubleshooting

For error messages or hardware problems encountered with your Filmetrics instrument, please use the
chart below to best diagnose your problem. For help with modeling, see Troubleshooting - Thickness
Modeling.

Question 1: Are you able to start FILMeasure without an error message?
No: Continue to Question 2.
Yes: Continue to Question 1-1.

Question 1-1: What sort of problem are you seeing?
1: The lamp doesn't turn on or the fan isn't working properly. See theNon-Operating Box, Lamp, or Fan
Troubleshooting Guide.
2: I get an error message when I click on something. Continue to Question 1-1-2.
3: Measurement results are wrong or unstable, after they had been good. See theMeasurement Results
are Incorrect or Unstable Troubleshooting Guide.
4: Measurement and/or baseline takes longer than it used to. See the Slow Operation Troubleshooting
Guide.

Question 1-1-2: If you're still seeing an error after you've power cycled and installed new software,
then select the description which most closely describes your error.
1: The error occurs during the baseline. See the Error Message During Baseline Troubleshooting Guide.
2: Some other error. See the Error Messages -Miscellaneous Troubleshooting Guide.

Question 2: Are you able to launch FILMeasure but it shows an error?
Yes: Continue to Question 2-1.
No: Then you need to install the software that comewith your new system, or you can request new
software. See the Software Reinstallation Guide.

Question 2-1: Does the error message start with "No Filmetrics instruments detected...."?
Yes: See theNon-Operating Box, Lamp, or Fan Guide.
No: See the Error Messages - Miscellaneous Troubleshooting Guide.

3.6.1 Power Cycling
Over the years we've found that about a third of support issues can be resolved by simply power cycling
the Filmetrics system and computer. Follow the simple steps below to power cycle your instrument.
Further assistancemay be received by contacting us using themethods described in the Contact
Information section.
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Step 1: Shut down FILMeasure (it's OK in the rare case that you can't).

Step 2: Unplug all electrical connectors from the back of your Filmetrics box.

Step 3: Restart your computer, giving it time to load all drivers.

Step 4: Reconnect the electrical connections to your Filmetrics box. (Make sure that the power cord is
getting power, and that any switch near the power connector is turned on.)

Step 5: Restart FILMeasure

3.6.2 Software Reinstallation Guide
Follow the steps below to reinstall FILMeasure. Further assistancemay be received by contacting us
using themethods described in the Contact Information section.Warning: Upgrading software
versions may result in slightly different (<1%)measurement results due to continual improvement of our
solving algorithms and material files.

Step 1: Shut down FILMeasure (it's OK in the rare case that you can't).

Step 2: Unplug all electrical connectors from the back of your Filmetrics system.

Step 3: Are you installing this software on a computer which already has FILMeasure installed?
Yes: Go to Step 4.
Yes: Jump to Step 6.

Step 4:Make a backup copy of your recipe and material files:
FILMeasure versions 1 thru 4: Backup the directory C:\Program Files\FILMeasure
FILMeasure versions 5 and up:
On Windows XP: Backup the directory C:\Documents and Settings\All
Users\Application Data\Filmetrics
Note: The application Data folder may be hidden by default.
On Windows 7/8/Vista/10: Backup the directory C:\Program Data\Filmetrics\
Note: The Program Data folder may be hidden by default.

Step 5: Uninstall the current version of software:
On windows XP: Click Start > Control Panel > Add or Remove Programs > FILMeasure > Uninstall
On Windows 7/Vista: Click the Start orb > Control Panel > Programs and Features > FILMeasure >
Uninstall
On Windows 8: Control Panel >More settings > Programs and Features > FILMeasure > Uninstall

Step 6: Run the software installer and follow installer instructions.
Note: you will need administrative privileges to install the software.
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Step 7: Reconnect your Filmetrics system.
Note for Windows XP: The "NewHardware Found" wizard may appear if your instrument has a
USB connection. Youmust click "Next and complete the driver installation process. This dialog box
may appear multiple times depending on the system configuration.
Note for Windows 7/8/Vista: An Information balloon may appear over the taskbar while drivers
are being installed. Please wait until the balloon indicates the drivers have been installed before
starting FILMeasure.

Step 8: Run the software to verify the installation was successful.

3.6.3 Non-Operating Box, Lamp, Or Fan
Follow the steps below to troubleshoot symptoms of a non-operating spectrometer, light source, or fan.
These are usually caused by having too much or not enough light. Further assistancemay be received by
contacting us using themethods described in the Contact Information section.

Step 1: Does the green LED on the right side of the front panel illuminate?
Yes: Jump to Step 3.
No: Go to Step 2.

Step 2: Is the power cord fully inserted into the back of the unit and a powered wall outlet? If your unit
has a rear power switch, is it on?

Yes: Go to Step 3
No: Plug into a powered outlet or switch on the unit

Step 3: Does the LED light on the light source switch illuminate when switched on?
Yes: go to Step 4
No: Possible faulty switch or faulty indicator lamp, contact Filmetrics.

Step 4: Is the cooling fan spinning? Determine this by listening to the cooling fan which is located
directly below the light source. (You'll need to get close to hear the fans on systems built after 2010.) For
F50 systems the chassis cooling fan is louder than the light source cooling fan. You'll need to get close to
the light source to hear the light source cooling fan.

Yes: Go to Step 5.
No: The cooling fan needs replacement, contact Filmetrics. Note: a bad cooling fan can draw
enough power to prevent the light source and box from operating properly.

Step 5: Does the light source illuminate?
Yes: Go to Step 6
No: The lamp has burned out. Please replace the lamp following the instructions here. A spare lamp
is included with most systems and additional lamps may be purchased on our website
www.filmetrics.comNote: users can confirm a bad halogen lamp by removing it and checking it
for electrical continuity.

http://filmetrics.com/accessories/replacement-lamps
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Step 6: The following steps are to troubleshoot a box that is not being detected by the FILMetrics
software. This could be a software driver or (rarely) a hardware problem. To see what hardware your
computer is detecting, look in the windows devicemanager. (instructions on how to access the Device
Manager are included at the end of this document.)

In the DeviceManager, which device do you see?

"Filmetrics Measurement Instrument" or similar: In this case the system should be operation
correctly. If not, please contact Filmetrics.
"Unknown Device" or similar: The hardware appears to be operating properly, but the drivers for
the hardware are not installed. If you have already power cycled and installed themost current
Filmetrics software, please contact Filmetrics for further assistance.
Neither of the above: The hardware is not working properly. Go to Step 7

Step 7: Try a newUSB cable and plug it into a different USB port. Does this fix the problem?
Yes: Either the USB cable or port was bad.
No: The USB controller inside the FILMetrics boxmay be bad. Please contact Filmetrics.

Accessing Device Manager in Windows 7:
1. Click on the Start Orb.
2. In the Star Search box type: devicemanager. Press enter.
3. Select Devicemanager from the list.
4. You should see a Filmetrics Measurement Instrument tab. Expand the tab and the appropriate
driver should be listed for the Filmetrics instrument.

Accessing Device Manager in Windows XP:
1. Click Start.
2. Click on Control Panel
3. In the Control Panel double-click the Systems icon.
4. In the Systems Properties window click on the Hardware tab.
5. In the Hardware tab click the DeviceManager button.
6. You should see a Filmetrics Measurement Instrument tab. Expand the tab and the appropriate
driver should be listed for the Filmetrics instrument.

3.6.4 Error Message during Baseline
Follow the steps below to troubleshoot error messages encountered while taking a baseline. These are
usually caused by having too much or not enough light. Further assistancemay be received by
contacting us using themethods described in the Contact Information section.

Step 1:Which error message are you seeing while taking a baseline?
Received light signal is too bright: If you aremanually setting the integration time (see
Measurement Timing) then you need to reduce the integration time. Otherwise you can reduce the
light source intensity by using a flattening or neutral density filter. Optical filters can be purchased
on our website, www.filmetrics.com.

http://filmetrics.com/accessories/optical-filters
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Baseline Failure. Reference and background spectra are almost the same: This error is often
caused by using the reference sample during the background step or vice versa, and is easily
corrected by taking retaking the baseline while providing the proper material for the proper step. If
this is not the case, go to Step 2.
Spectrometer peak intensity is x% of previous reference intensity: This error is often caused by
using the incorrect reference sample and is easily corrected. Jump to Step 5.

Step 2: Does the light source illuminate?
Yes: Go to Step 3.
No: Check theNon-Operating Box, Lamp, Or Fan Troubleshooting Guide.

Step 3: Check to see if there is a broken or misconnected fiber. With the light source on, confirm that
the illumination fiber is screwed into the light source securely, and that plenty of light is exiting the fiber
at the far end near where the sample is placed. The light can be seen by placing paper (e.g., business
card) near the sample location (do not look directly into the fiber if you are using a UV source). If plenty of
light is seen, next check the return fiber by removing it from the spectrometer input and connecting it to
the light source (removing the other fiber first). You should see light at the far end as before, but it may
be 3-4 times smaller and dimmer. Did you see light at the sample end using both fibers in the light
source?

Yes: The fiber appears to be good. Replace the fibers securely in their original positions (there will be
a white band on the light source fiber if the two ends are different) and go to Step 4.
No: The fiber optic may be broken. Replacements can be purchased on our website,
www.filmetrics.com

Step 4: Does your system havemultiple spectrometers (i.e. EXR or UVX)
Yes: Check the Acquisition Settings tab under Edit Recipe to make sure that your fiber optic
configuration matches the enabled spectrometers. Do this by making sure that each enabled
spectrometer has a fiber attached to it (or disable a spectrometer that is not being used).
No: If you are still experience problems, please contact us using the Contact Information section.

Step 5:Was the correct reference selected from the drop-down list?
Yes: Go to Step 6.
No: Re-baseline using the correct reference.

Step 6: Has the light source lamp recently been changed?
Yes: This error is an expected response, no further action required
No: Go to Step 7.

Step 7: Has the optical configuration been altered (i.e. switching from standard spot size to small spot
optics or a contact probe)?

Yes: This error is an expected response, no further action required
No: If you are still experiencing problems, please contact us using the Contact Information section.

3.6.5 Measurement Results are Incorrect or Unstable.

http://filmetrics.com/accessories/fibers
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Follow the steps below to troubleshoot when measurement results are incorrect or unstable after the
results had been good for some time. Additional help troubleshooting general measurement issues may
be found in the Troubleshooting: Thickness Modeling section. Further assistancemay be received by
contacting us using themethods described in the Contact Information section.

Step 1: First confirm that you have selected the correct recipe for the sample that you aremeasuring
(i.e., the same recipe that previously was giving good measurements). Note that this troubleshooting
guide does not cover instances where recipe parameters have been changed.

Step 2: Confirm that the light source is turned on and that the fibers are securely tightened into the
light source and the spectrometer input Place a piece of paper at the samplemeasurement location and
confirm that you can see a light beam. Can the light beam be seen?

Yes: Jump to Step 4
No: Go to Step 3

Step 3: Is there light coming out of the light source? (If you are checking a UV light source, put on the
goggles that were supplied with the light source before checking.)

Yes: It appears the fiber may be broken. Replacements can be purchased on our website
www.filmetrics.com
No: Replace the lamp following the instructions here. A spare lamp is included with most systems
and additional lamps may be purchased on our websitewww.filmetrics.comNote: users can
confirm a halogen bad lamp by removing it and checking it for electrical continuity.

Step 4: Perform a new baseline, paying particular attention to make sure that you are using the proper
reference and that it is clean with the correct side up.

Step 5: Put a sample that is known to be good on the stage and perform a measurement. If the
measurement is still not correct, go to Step 6.

Step 6: Your lamp may be weak and needs to be replaced. The best way to tell is to replace it with the
instructions found here. A spare lamp is included with most systems and additional lamps may be
purchased on our websitewww.filmetrics.com.

If you are still experiencing problems with an unstable or incorrect measurment after the preceding
steps, please contact us using themethods described in the Contact Information section.

3.6.6 Slow Operation Troubleshooting Guide
Follow the simple steps below to troubleshoot slow system operation. Further assistancemay be
received by contacting us using themethods described in the Contact Information section.

Step 1:When did you experience the slow operation?
During a baseline: Go to Step 2.
When I click Measure: Jump to Step 7.

http://filmetrics.com/accessories/fibers
http://filmetrics.com/accessories/replacement-lamps
http://filmetrics.com/accessories/replacement-lamps
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Step 2: Slow baselines are generally caused by a low light level, which can have several causes. Does the
light source illuminate (be sure it is switched on, and that the shutter is open on UV systems)

Yes: Go to Step 3.
No: Check theNon-Operating Box, Light, or Fan Troubleshooting Guide.

Step 3: Check to see if there is a broken or misconnected fiber. With the light source on, confirm that
the illumination fiber is screwed into the light source securely, and that plenty of light is exiting the fiber
at the far end near where the sample is placed. The light can be seen by placing paper (e.g., business
card) near the sample location (do not look directly into the fiber if you are using a UV source). If plenty of
light is seen, next check the return fiber by removing it from the spectrometer input and connecting it to
the light source (removing the other fiber first). You should see light at the far end as before, but it may
be 3-4 times smaller and dimmer. Did you see light at the sample end using both fibers in the light
source?

Yes: The fiber appears to be good. Replace the fibers securely into their original positions on the
spectrometer box and light source (there will be a white band on the light source fiber if the two
ends are different) and go to Step 4.
No: The fiber optic may be broken. Replacements can be purchased on our website,
www.filmetrics.com

Step 4: Does your system havemultiple spectrometers (i.e. EXR or UVX)
Yes: Check the Acquisition Settings tab under Edit Recipe to make sure that your fiber optic
configuration matches the enabled spectrometers. Do this by making sure that each enabled
spectrometer has a fiber attached to it (or disable a spectrometer that is not being used).
No: Go to Step 5.

Step 5: It may be that your lamp is old and needs to be replaced. The best way to tell is to replace it
with the instructions found here. A spare lamp is included with most systems and additional lamps may
be purchased on our websitewww.filmetrics.com.

Step 7: Unless the slow operation during measurement is a new problem, please confirm that your
computer meets theminimum system requirements as listed in the system specifications. If it doesn't,
please upgrade your computer. Otherwise, go to Step 8.

Step 8: Ameasurement that takes a long time generally means that there is a large amount of
processing required to find a solution, which is usually caused by a non-optimal recipe setting. Please
first confirm that you have selected the correct recipe for the film stack you aremeasuring. Otherwise, go
to Step 9.

Step 9:Open the recipe and make sure that you are not solving for too many parameters. Solving for
one or two thicknesses or a thickness and index should only take a second or two, but in some
circumstances the solving time can be increased 5-10x for each additional parameter. Solving for
nonuniformity (or adding it to increase accuracy of other parameters) can be especially time consuming.

http://filmetrics.com/accessories/fibers
http://filmetrics.com/accessories/replacement-lamps
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Step 10: If you are solving for more than one thick layer (i.e., >10 um), you can speed up the solving
process by reducing the thickness constraint range (which can be safely reduced even more by using an
accurate nominal thickness guess)or by switching from using theGrid solver to the FFT solver in the
recipe.

If you are still experiencing problems with a slowmeasurement after the preceding steps, please contact
us using themethods described in the Contact Information section.

3.6.7 Error Messages - Miscellaneous Troubleshooting Guide
This guide provides extended information on error messages a user may encounter on rare occasion
while using our software. Further assistancemay be received by contacting us using themethods
described in the Contact Information section.

Error during spectrum analysis/ unable to analyze spectrum.
This error is generally caused by a problem with the recipe constraints. Try adjusting the solver
wavelength range, thickness constraint range, or starting thickness value. Also make certain that the
starting thickness values have been entered using the correct units ofmeasure specified for the recipe.

Spectrum saturated.
This error indicates that the samplemeasured is more reflective than the spectrometer was expecting.
Reflectance data may not be accurate as a result. Take a new baseline to fix this problem.
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3.6.8 Troubleshooting: Measurement Results
In all cases it has been assumed that the user has read theMeasurement Assumptions section, and that
each criterion has been met.

Case #1: No oscillations, or portions of oscillations, are present in the measured reflectance
spectrum.

Case #2: The measured reflectance spectrum has periodic oscillations across the entire screen, but its
minima and maxima do not match up with the calculated reflectance.

Case #3: Two or more different, but nearly the same, thickness readings are obtainable from the
same measurement location.

Case #4: Poor matches between the measured and calculated reflectance spectra when measuring
thickness and optical constants.

Case #5: Several different answers, or one unreasonable answer, are found when measuring
thickness and optical constants, even though a good match is found between the measured and
calculated reflectance spectra.

Case 1: No oscillations, or portions of oscillations, are present in the measured
reflectance spectrum.
There can be several possible causes in this case;

1. The film may just be very thin (<200 Å), thus presenting no discernible oscillations or only one
identifiable minima or maxima. The FFT solver will not be able to accurately analyze films without at least
one discernible full oscillation, in general meaning a film less than 0.2microns thick. Use one of the
Spectrum Matching solver methods (Robust, Exact) to analyze very thin films.

Note: The Spectrum Matching solvers are only available on systems that have at least the UPG-RT-to-Thickness.

2. If the film is very rough, non-uniform in thickness over themeasurement area, or has a graded
interface it may not support coherent optical interference and thus it may not be able to bemeasured.
Try moving to a different measurement spot for a better signal.

3. An improper baselinemeasurement was taken, for example a thickness standard is presented as a
reflectance standard. Re-baseline the system while taking care to select the proper reflectance standard
and reference file.
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Case 2: The measured reflectance spectrum has periodic oscillations across the
entire screen, but its minima and maxima do not match up with the calculated
reflectance.
Themost common cause is that the initial thickness guess was considerably different than the actual film
thickness, and due to the constraints on possible thicknesses, FILMeasure was unable to find the correct
answer.

To better understand this, it helps to know that the number of oscillations on the screen is proportional
to the film thickness. For example, if themeasured spectrum has roughly twice the number of the
oscillations that the calculated spectrum has, then themeasured film is roughly twice the thickness of
the calculated thickness. Using this information, the initial thickness guess and the thickness constraints
can be set more appropriately in the Edit Recipe dialog box. Another possible cause is found in Case #3
(incorrect dispersion).

Case 3: Two or more different, but nearly the same, thickness readings are
obtainable from the same measurement location.
When this occurs usually themeasured and calculated spectra match somewhat, but not very well
across the entire spectra (i.e., themeasured and calculated spectra match exactly only over a small
wavelength range and then gradually walk off one another outside this wavelength range). When
thickness is the only value being measured, this is normally caused by the refractive index of the
measured layer not matching that used by FILMeasure, especially when the film is greater than one
micron thick. Unless more accurate index values can be obtained, the best way to solve this problem is to
restrict the wavelength range used in the analysis.

Case 4: Poor matches between the measured and calculated reflectance spectra
when measuring thickness and optical constants.
There can bemany causes of this problem, including those listed in Case #1 and Case #2 above. Most
commonly when a poor fit between the spectra occurs, it is because:

1) The components of the film structure are not all included in the Edit Recipe > Film Stack dialog
box. Adjust the recipe accordingly and reanalyze the spectrum.

2) Very inaccurate initial guesses for the film thickness(es) have been listed. Try a new nominal
starting guess, or expand the thickness constraint range.

3) The optical constants listed in the Edit Recipe > Film Stack dialog box are far from the actual
optical constants in thematerial. Try selecting a different but similar material file if one is present,
for example switching from Acrylic to Acrylic - 2.
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4) The film being measured has properties that are not taken into account by FILMeasure. Examples
of these properties are graded interfaces and non-uniform films. You can enable solving for these
conditions in the recipe.
Note: Enabling Nonuniformity solving will increase solving time.

Case 5: Several different answers, or one unreasonable answer, are found when
measuring thickness and optical constants, even though a good match is found
between the measured and calculated reflectance spectra.
This normally occurs when a large number of properties are being measured on a very thin film. In
general, the thinner a film is the less unique information that can be obtained from it. To understand
this, see Theory of Operation. To solve the problem, you can either:

A. Decrease the number of variables solved for.
B. Increase the amount of data provided to the solver (analyzing reflectance and transmittance at the
same time, or using themulti-spectral solver).
C. Enablemultiple Solver Cycles under the Edit Recipe > Analysis Options > Advanced dialog.
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4. Understanding and Evaluating
Measurement Results
This section covers information on theDisplay of Measured Spectra and a more in depth look at the
Goodness Of Fit value.

4.1 Display of Measured Data

Once film stack and measurement information have been entered and a baseline has been taken,
measurements may bemade by clicking on theMeasure button. After measurement, themeasured and
calculated reflectance spectra are displayed on the graph, and the thicknesses of the films are listed in
the results box. If any of the thickness values weremeasured, they are displayed in bold numbers.

The quality and accuracy of the result is determined by howwell themeasured spectrum matches with
the calculated spectrum. In general, thickness information is determined by the number of oscillations,
and index information is determined by the amplitude of the oscillations. In the case of the Robust
(adaptive; thickness only) solver and Exact Spectrum Matching solver, a good result is one where the
minima and maxima of themeasured and calculated spectrum align. For the FFT (thickness only) solver,
this is when themeasured intensity peaks overlap. See theGoodness of Fit and Troubleshooting -
Thickness Modeling sections for more information.

4.2 Goodness of Fit

The accuracy of a calculation fit, and thus the reliability of themeasurement, can be judged by thematch
between themeasured and calculated spectra, which is quantified by the GOF value. GOF is a number
between 0 and 1.

A perfect match between measured and theoretical spectra will result in a GOF of 1. To ensure accurate
results the user may set a minimum acceptable GOF value by entering a number between 0 and 1 into
GOF Error on the Alarms Tab in the Edit Recipe dialog box. Awarning message will be displayed after
each measurement where the GOF falls below the user-specified GOF Error. If the GOF is less than 1 there
are several possible causes:

a) Nonuniformity – Any variation of layer thickness, or presence of roughness, within the
measurement spot will result in a reduction in reflectance. In severe cases the interference peaks
may disappear entirely.

b) Incorrect Structure Definition – If the refractive index of one or more layers in the structure is
different from what is described in the recipe, then there will be somemismatch between the blue
curve and the red curve.
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c) Graded Interfaces – The amplitude of the peaks in the spectrum depends on both the size of the
change in refractive index at each interface in the layer structure and the sharpness of the interface.
For example, in many hardcoat samples there is some degree of layer intermixing at the interface,
leading to a weaker than expected reflectance at that interface. In severe cases the peaks may
disappear entirely.

4.3 Fast Fourier TransformMode (FFT mode)

The FFT mode tends to bemore robust when measuring very thick films or thick multi-layer stacks,
where the total thickness is greater than 5microns.

To activate FFT mode, select the select FFT (thickness only) button located on the Analysis Options >
Analysis Method tab in the Edit Recipe box.

The Measure Tab shows a split screen with the measured spectrum on the top graph and the FFT spectrum on the
bottom graph.

In FFT mode, instead ofmatching themeasured reflectance spectrum with a calculated reflectance
spectrum, FILMeasure identifies the peaks in the FFT Spectrum and uses them to compute the layer
thicknesses. The number of possible FFT peaks is n*(n+1)/2 where n is the number of layers. Thus, for a
two layer structure, we expect to see three peaks in the FFT spectrum.
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The image above shows the screen just after measurement of a two layer stack using FFT mode. The
upper graph shows a blue curve representing the reflectance spectrum of the sample. The lower graph
shows a blue and red FFT spectrum. The blue FFT spectrum is computed from themeasured reflectance.
The red FFT spectrum is computed from the theoretical reflectance spectrum of a layer stack with the
measured layer thicknesses. The small side lobes visible on either side of the two tall peaks are artifacts of
the FFT process and can generally be ignored. The only time the side lobes will cause a problem is if a
weak peak from a multi-layer sample is very close to a much stronger peak. If this case occurs
FILMeasuremay lock onto one of the side lobes by mistake and it may not be possible to measure the
layer thickness associated with the weak peak. Reducing the Constraint and/or increasing the guess for
the thickness for the layer with the weak peak may be helpful in getting FILMeasure to lock onto the
weak peak. If the peak is too weak to reliably measure it is best to change the layer structure definition so
that the layer corresponding to the weak peak is eliminated.

Along with themeasured layer thicknesses, the Results text box displays important information about
themeasurement. This important information includes theGoodness Of Fit (GOF) and a description of
which peaks were used to determine themeasured layer thicknesses. In the figure above layer 1
thickness is determined based on the position of the peak located at 4.780microns and layer 2 thickness
is determined using the peak corresponding to layers 1+2 (7.011microns). Notice that the thickness of
layer 2 is not exactly equal to 7.011-4.780 = 2.231microns. FILMeasure computes a thickness for layer 2 of
2.113microns because it precisely accounts for the fact that layer 2 has a different refractive index than
layer 1.

Discussion of GOF:
A perfect match between measured and theoretical FFT spectra will result in a GOF of 1. To ensure
accurate results the user may set a minimum acceptableGOF value by entering a number between 0 and
1 into GOF Error on the Alarms settings in Edit Recipe. A warning message will be displayed after each
measurement where theGOF falls below the user-specified GOF Error. If theGOF is less than 1 there are
several possible causes as follows:

a)Nonuniformity – Any variation of layer thickness within themeasurement spot will result in a
reduction in the FFT peak heights. In order to permit easy visual interpretation of the FFT results
FILMeasure always scales the amplitude of the red curve so that it matches the blue curve.
However, if the scaling factor is not 1.0, FILMeasure reports a reduced GOF even if the red curve
appears to exactly match the blue curve on the screen.

b) Incorrect Structure Definition – If the refractive index of one or more layers in the structure is
different from what is described in the layer structure, then the FFT peak amplitudes in the blue
curve will not match the peak heights in the red curve. The software will attempt to scale the red
curve, but if there is more than one FFT peak present, the scaling will only result in one correct peak
height. If you wish to view the impact of changing the refractive index of one or more layers, simply
change the refractive index in the Edit Recipe dialog box and click Analyze. If there is only a single
layer you will notice that the GOF will change, but the red curve should not changemuch. If there
aremultiple layers in the structure you will notice that the relative peak heights in the red curve will
change when you click Analyze.
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c)Graded Interfaces – The amplitude of the peaks in the FFT spectrum depends on both the
difference in refractive index at each interface in the layer structure and the sharpness of the
interface. In many common samples you will find that there is some degree of layer intermixing at
the interface, leading to a weaker than expected reflectance at that interface. The FFT peak(s)
associated with the intermixed interface will suffer a reduced amplitude and in severe cases the
peaks may disappear entirely.
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5. Advanced Features
This section describes how to create and edit material files within Windows Excel.

Creating and Editing n and k Files

5.1 Creating and Editing n and k Files

Creating new n and k files
New n and k files can be created by going to Edit > Material Library… Clicking theNew button will allow
the user to define a newmaterial file. Once clicked, while theDefault Model is selected, the user can
manually enter wavelength versus n or wavelength versus k values. It is also possible to copy and paste
values into the columns if the data is available.

The user can also select Custom Model. While this is selected, clicking on theModel… button allows the
user to create n and k files using predefined mathematical models.

Once completed, clicking Save As…will save the new file as a custom material for later use.

Creating n and k files from a calculated spectrum
Files for n and k can be created directly from a calculated spectrum, where n and k aremeasured. Once a
spectrum is analyzed, go to File>Save Measured n and k… This will save your n and k files as a custom
material which can be loaded into the user recipe.

Editing n and k files
Existing material files can be edited by going to Edit > Material Library… There, the user can load a
material file by clicking Open. Values can then be changed manually. Clicking Savewill save over the
original file for later use. Use Save As to save the edited file under a new name.

Converting Microsoft Excel files into FILMeasure n and k files
For wavelength versus n or wavelength versus k data saved in Excel (*.xls) format, the data can be
directly saved as material files that can be read by FILMeasure.

For .nnn and .kkk files.
For both n and k files, the data should follow the format shown below, where the wavelength values, in
units of nanometers, are in the first column, and the n or k values are in the second. Note that the
version number (cell B1) refers to version of the file. For this cell, you can use 1. Thematerial number (cell
B2) refers to what material category the file corresponds to. Thematerial categories (and their
corresponding numbers) are: Metal (1), Semiconductor (2), Dielectric (3), Other (4), and Photoresist (6).
By putting the correct value for thematerial number, the file will automatically be sorted into the correct
category when selecting thematerial in the Edit Recipewindow.
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To save the file created by Microsoft Excel, go to File>Save As… For Save as Type: choose CSV (Comma
delimited) (*.csv). For n files, save the file as “FILENAME.nnn”, and for k files, save the file as
“FILENAME.kkk” (FILENAME represents the name you wish to call the file; note that quotation marks
must be used to enclose the filename in Excel to force the extension to .nnn or .kkk). The file can then be
saved to the desktop, and Imported using the File > Import > Material File option

For .fitnk files.
The data should follow the format of shown below, where the wavelength values, in units of
nanometers, are in the first column, index of refraction (n) in the second, and extinction coefficient (k) if
present, in the third.

The first few columns of the file should be identical to the figure below the only exception being cell B3
which should contain a number describing thematerial category. Thematerial categories (and their
corresponding numbers) are: Metal (1), Semiconductor (2), Dielectric (3), Other (4), and Photoresist (6).

To save the file created by Microsoft Excel, go to File > Save As… For Save as Type: choose CSV (Comma
delimited) (*.csv). Save the file as “FILENAME.fitnk” (FILENAME represents the name you wish to call the
file; note that quotation marks must be used to enclose the filename in Excel to force the extension to
.fitnk). The file can then be saved to the desktop, and Imported using the File > Import > Material File
option
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6. Theory of Operation
This section describes how the instruments work and includes the theory themeasurements are based
on, specifics about the hardware, and more detail about the baselinemeasurement.

Measurement Theory

Thickness Measurement Details

Hardware Operation

The Baseline Measurement

6.1 Measurement Theory

Our instruments measure thin-film characteristics by either reflecting light from, or transmitting light
through the sample, and then analyzing this light over a range of wavelengths. Because of its wave-like
properties, light reflected from the top and bottom interfaces of a thin film can be in-phase so that
reflections add, or out-of-phase so that reflections subtract. Whether the reflections are in- or out-of-
phase (or somewhere in between) depends on the wavelength of the light, as well as the thickness and
properties of the film (e.g., reflections are in-phase when λ = (2*n*d)/i, where λ is the wavelength, n is the
refractive index, d is the film thickness, and i is an integer). The result is characteristic intensity oscillations
in the reflectance spectrum (see Figure below). In general, the thicker the film, themore oscillations there
are in a given wavelength range.

Example of reflectance spectrum with oscillations.
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The amplitude of the oscillations is determined by the refractive index and extinction coefficient of the
films and substrate. Therefore, by analyzing the period and amplitude of these oscillations, our
instruments can determine thickness ofmultiple thin films.

6.2 Thickness Measurement Details

Optical thin-film thickness measurements require the successful completion of two tasks: acquisition and
then analysis of an accurate reflectance spectrum. To determine film thickness, FILMeasure calculates a
reflectance spectrum that matches as closely as possible themeasured spectrum. FILMeasure begins
with an initial guess for what the reflectance spectrum should look like theoretically, based on the user’s
input of a film structure for the sample. Then FILMeasure varies the parameters it is solving for until the
calculated reflectance spectrum matches themeasured data. Mathematically, this procedure is
complicated by the fact that as the thickness of the films in the calculation is varied there can bemany
near matches. Therefore, an approach that simply homes in on a solution by finding successively better
approximations will not work unless the starting guess for optical thickness is within approximately 1000
Å if the actual thickness.

FILMeasure avoids homing in on a false solution by searching the entire acceptable thickness range to
determine the thickness that gives the best possible match between themeasured and calculated
spectra. The thickness range searched is determined by the initial guess for thickness together with the
thickness constraint. Since the time to find a solution is proportional to the range of thicknesses being
searched it is beneficial to provide an initial guess close to the thickness of the films to bemeasured.

6.3 F10-RT Hardware Operation

The F10-RT performs two distinct functions: data acquisition and data analysis. Data analysis specifics are
discussed in Software Overview. In this section we describe how the F10-RT acquires accurate spectral
reflectance data.

Light is supplied by a tungsten-halogen bulb that generates light from approximately 375 nm to 3000 nm.
This light is delivered to and collected from the sample through a fiber-optic cable bundle and a lens. The
intensity of the reflected light is measured at 1024 different wavelengths with a spectrometer. The F10-RT
spectrometer uses a diffraction grating to disperse the light and a linear photodiode array to measure
the light at the different wavelengths. The photodiode array operates by integrating the current
generated by light falling on each of the 1024 pixels. After a user-selectable integration time, the
accumulated charge in each photodiode is read by the computer. Because a longer integration time
results in a larger charge, it is the integration time that determines the sensitivity of the spectrometer.
Adjustment of the integration time is used to obtain the proper signal level. Too short an integration
time results in a weak, noisy signal, while too long of an integration time results in a saturated signal. An
optimized integration time is set in the software during the baseline process.
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6.4 The Baseline Measurement

The baselinemeasurement allows the FILMeasure software to take into account the response inherent
to the reflectancemeasurement hardware. It does this by measuring a reflectance standard and by
taking a “dark” reading. In any optical system there aremany components whose characteristics vary
with wavelength (e.g., the output of the light source and the sensitivity of the spectrometer). However,
when reflectancemeasurements aremade, only variations in reflectance vs. wavelength due to the
sample under test are of interest. Therefore, FILMeasuremust perform a calibration to determine the
spectral response of the system. This is done by making a measurement of a reflectance standard that
has known reflectance characteristics. Note that it is not necessary for the reflectance standard to be the
same as the substrate upon which films to bemeasured reside. The only purpose served by the
reflectance standard is to permit calibration of the optical system. For example, it is possible to use a Si
wafer as the reflectance standard and then measure films on GaAs, InP, glass, plastic, etc.

After the referencemeasurement is made a dark reading is taken. A non-zero dark level is due to current
leakage inherent to photodiodes, which causes each photodiode in the array to slowly charge up even
when no light enters the spectrometer. Thus, in order to make an accuratemeasurement of the light
entering the spectrometer, it is necessary to subtract this “dark” current contribution. This is the
purpose of the background reading, which measures themagnitude of the dark current for a given
integration time. When a “dark” measurement is made, a spectrum is measured that represents the
signal generated by the spectrometer when a sample of zero reflectance is measured. To simulate a
sample with zero reflectance during a “dark” measurement, a specularly reflecting sample can be held at
an angle with the light source turned on, or in the case of the UV light source, the shutter may simply be
closed.

Due to drift in the light source and temperature of the spectrometer electronics, it is a good idea to take
a baseline periodically.
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How to Contact Us
Wewelcome suggestions from our users on ways to improve our software and hardware. Please send us
any suggestions you may have for improvements in the help file or new features you would like to see in
the software.

Wemay be reached by phone at +1-858-573-9300, by fax at +1-858-573-9400, by the Contact Us Now form
on our website, or by e-mail at support@filmetrics.com.

http://filmetrics.com/forms/generic
mailto:support@filmetrics.com?subject=Tech Support Request?subject=Tech Support Request
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7. Appendices
This section contains information on various topics as listed below:

Performance Specifications

How to Replace the Light Bulb

Automation and Data

Software License Agreement
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7.1 Performance Specifications

Wavelength
Range

Thickness
Range1

Min. Thickness
to Measure n

and k1

Accuracy1:
Greater of
0.2% or

Precision2 Stability3

F10-RT-UV 190-1100 nm 1 nm to 40 µm 50 nm 1 nm 0.02 nm 0.05 nm

F10-RT-UVX 190-1700 nm
1 nm to 150

µm
50 nm 1 nm 0.02 nm 0.05 nm

F10-RT 380-1050 nm
15 nm to 70

µm
100 nm 2 nm 0.02 nm 0.05 nm

F10-RT-EXR 380-1700 nm
15 nm to 150

µm
100 nm 2 nm 0.02 nm 0.05 nm

F10-RT-NIR 950-1700 nm
100 nm to 150

µm
500 nm 3 nm 0.1 nm 0.12 nm

Probe Spot Size: 6mm
Sample Orientation: Face down
Light Source (F10-RT, NIR, and EXR): Regulated
Tungsten-Halogen.
Light Source (UV, UVX): Regulated Deuterium &
Tungsten-Halogen.
Lamp Warm Up Time for High Precision: 15Minutes
Power Requirements: 100-240 VAC, 50-60 Hz, 20W

Wavelength Accuracy4: Better than 0.5 nm
Wavelength Reproducibility4: 0.1 nm
Wavelength Resolution4: 2.5 nm
Reflectance Accuracy for R≤RStd4 5: 0.005* RStd
Reflectance Accuracy for R>RStd4 5: 0.005*
Rmax/RStd
Transmittance Accuracy4 6: 0.005* Tmax/TStd +
0.001
Noise4: < 0.0002 A rms
Stray Light4: < 0.25% at 500 nm
Amplitude Resolution4: 14-bit

1 Material dependent.
2 1σ of 100 measurements of 500 nm SiO2-on-Si. Average of 1σ over 20 successive days.
3 2σ of daily average of 100 measurements of 500 nm SiO2-on-Si over 20 successive days.
4 Specifications for 400-950 nm unless otherwise noted.
5 RStd is reflectance of the reflectance standard used. Rmax is the maximum measured reflectance over the
wavelength range. Sample must be flat to <0.03o.
6 TStd is transmittance of the transmittance standard used. Tmax is the maximum measured transmittance over the
wavelength range.

Specifications subject to change without notice.
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7.2 Light Bulb Replacement

NOTE: These instructions apply to VIS, NIR, and EXR systems only. For UV and UVX systems, please
see the seperate users manual for the external light source.

* * Warning: * * Hazardous voltages are present within the unit. Never attempt
any maintenance without disconnecting the power cord.

Step by step:
1. Exit FILMeasureprogram and turn off your computer.

2. Disconnect power cable from the F10-RTfrom the back of the unit.

3. Open the Light Source Access by unscrewing the two screws on the back panel.

* * Warning: * * Caution, avoid touching any interior components, other than
the lamp, lamp base, and housing.
4. Loosen lamp set screw (counter clockwise to loosen).

5. Insert new lamp fully into lamp housing. Do not touch the lamp glass.

6. Secure lamp with setscrew (clockwise). Do not over tighten.

7. Plug new lamp into the lamp power connector. Do not test lamp with lid removed.

8. Replace the assembly into the Light Source Access opening and fasten the screws. Insert cord into wall
supply and test light. 

9. The lamp should illuminate and the fan should turn when power is restored. The light switch on the
front of the F10-RT boxmust be turned on.
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7.3 Software Automation

Measurements can be automated and additional data analysis can be performed by user-supplied
software. Themechanism by which this occurs is either by using the FIRemote class, which is part of
FILMeasure.exe or by using the FIRemoteCOM dll (standard 32-bit version of FILMeasure). Accessing the
FIRemote class directly using a .NET programming language such as C# offers themost flexibility and is
the recommended approach. Alternatively, the FIRemoteCOM dll can be referenced from Microsoft
Office programs and simple software procedures can be implemented there instead. The FIRemoteCOM
dll includes fewer methods than FIRemote. Documentation for FIRemoteCOM dll is located at the end of
this section.

FIRemote Class
FIRemote is exposed as a public assembly and is accessible using theMicrosoft .NET programming
environment. The best way to learn how to use the FIRemote class is to look at the example program
and source code which are automatically installed as part of the FILMeasure software. Assuming that the
FILMeasure program is installed in the default location, the example software can be found in
C:\Program Files\Filmetrics\FILMeasure\SourceCode\FIRemoteTest. Additionally an executable,
FIRemoteTest.exe, is located in the FILMeasure folder. All the available commands can be tested using
FIRemoteTest.exe.

In order to set up a development environment for running and debugging code, the file system must be
set up so that the FILMeasure.exe is located in the same folder as the client program that is being
developed. Since FILMeasure expects to find its dependent files in the same directory as the executable,
this means that the entire contents of the FILMeasure folder must be copied to the build output folder.
For example, if the software development environment output folder is located in
C:\SourceCode\TestSln\TestPrj\bin\Debug\, then all the files and subfolders from C:\Program
Files\Filmetrics\FILMeasure\ must be copied to C:\SourceCode\TestSln\TestPrj\bin\Debug\.

Some of themethods listed in the following reference a SystemGuid. In the terminology used in this
document, a Measurement System is an object comprising one or moremeasurement channels, but
with operations that can be performed simultaneously on all the channels in the system. The
SystemGuid is used to distinguish between multiple, simultaneously-connected measurement systems.
Examples ofmeasurement systems with multiple measurement channels include the F32.
Documentation for methods applying only to such measurement systems can be found in the Less
Commonly Used Methods section. In addition, somemethods will accept either a SystemGuid or a
ChannelGuid. Such methods thus will execute an operation either on a single channel, or simultaneously
on all channels of a system.

Note that the FIMeasResults object which is returned by theMeasure and AnalyzeSpectrum methods
has a large number ofmember functions and properties. Since the names are all self-explanatory, we
have not attempted to list all of themembers here. The reader should use the Object Browser which is
built into Microsoft Visual Studio in order to discover the available properties and methods.
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FILMeasure 7 and 8 are based on theMicrosoft .NET 4.0 Client Profile Framework. FILMeasure 5 and 6
were based on the .NET 2.0 Framework. Executable client programs and source code projects that were
built for FILMeasure 5 or 6will need to be recompiled, targeting the .NET 4 Client Profile Framework. The
Visual Studio development environment will display a warning message if you reference an assembly that
is targeting a framework different from that targeted by your development project. You must use Visual
Studio 2010 or newer, because the .NET 4 Framework was released with Visual Studio 2010. Do not
attempt to use Visual Studio 2008 or older because it will not work. The FIRemoteTest source code is
compatible with Visual Studio 2010. The FIRemoteTest solution file can be opened with newer versions of
Visual Studio, which will automatically upgrade the solution and project.

32-bit vs 64-bit Client Software
To maintain backward compatibility, the 32-bit version of FILMeasure is shipped by default. If your client
softwaremust interact with softwaremodules which are only available in 64-bit versions, then you must
use a 64-bit version of FILMeasure instead. Contact Filmetrics for access to an installer for the 64-bit
version of FILMeasure.
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Reference for FIRemote Class
Methods, Property and Events:

New
AcquireSpectrum
ActivateChannelDisplayTab
AnalyzeSpectrum
AuthenticateRefBac
BaselineAcquireBackgroundAfterRef
BaselineAcquireReference
BaselineAcquireReferenceT
BaselineAcquireReferenceUsingOldSampleReflectance
BaselineAcquireSpectrumFromSample
BaselineCommit
BaselineSetRefMat
BaselineShowDialog
GUIVisible
HistoryDeleteAllResults
IntegrationCycles
IntegrationTime_ms
MaximumSamplingTime
MeasurementTimingMode
MeasChannelGuid
MeasChannelGuids
MeasChannelHWName
MeasChannelHWSerialNumber
MeasChannelName
Measure
NumberOfChannels
NumberOfSpectrometers
NumberOfSubSystems
OpticsConfiguration
OpenSpectrum
OpenSpectrumFromBuffer
OperatorID
RecipeInfo
SampleID
SaveSpectrum
SaveSpectrumToBuffer
SetAnalysisWavelengthRange
SetMaterial
SetN
SetRecipe
SetRoughness
SetThickness
SetThicknessRange
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SpectrometerDiagnostics
SpectrometerType

Less-Commonly-Used Methods
The following methods are only rarely used. Methods which refer to a System are used with the F32 and
F37 thin film monitoring systems. Many methods accept either a measSystem or a measChannel guid.
However, somemethods are relevant only to a single channel. If you supply a measSystem guid as the
argument for one of thesemethods, an exception will be thrown.

ActivateMonitorDisplayTab
BaselineHardwareAdjustInhibit
BaselineExistsAndIsAuthenticated
GeneralPurposeIOIsSupported
GeneralPurposeIOReadValue
GeneralPurposeIOSetValue
GetBaselineHardwareAdjustStatus
MaterialPath
MaterialPathCustom
MeasSystemGuid
MeasSystemGuids
MeasSystemHWName
MeasSystemName
NumberOfSystems
RecipePath
RecipePathCustom
SaveImage
SetAutoFocus
SetRecipeModeToSpectrumAnalysis
SetRecipeSpectrumAnalysis
ShutdownRequestedHandler
ShuttingDown
SystemAutoSave
SystemAutoSaveBaseFileNameAndPath
SystemMeasure
SystemStartMonitoring
SystemStopMonitoring
SystemMeasurementCompletedEventHandler

New

Public Sub New(ByVal showFILMeasureGUI As Boolean) (deprecated)
Public Sub New(ByVal showFILMeasureGUI As Boolean, ByRef
theConstructorWarning As ConstructorWarning, ByRef warningMessage As
String)(deprecated)
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Public Sub New(ByVal guiType AsGraphicalUserInterfaceType, ByVal
guiStartupState AsGraphicalUserInterfaceStartupState, ByVal
guiWindowStartupState AsFormWindowState, ByRef theConstructorWarning
AsConstructorWarning, ByRef warningMessage As String)

guiType – Determines if the FIRemote user interface and associated objects will be constructed at
startup. IfguiType is set to None, then the startup process is accelerated and memory usage is
minimized. However, the user interface cannot be displayed at a later time if it is not constructed during
the startup process. IfguiType is set to Standard, then the normal graphical user interface is
constructed during the startup process.

guiStartupState – Determines whether or not the FIRemote user interface is displayed at startup. Note
that this argument has no effect ifguiType = None. IfguiStartupState is set to Hidden, then
the user interface will not be visible on screen at the completion of the startup process. If the user
interface was constructed at startup, it can be displayed at a later time by setting GUIVisible =
True.

guiWindowStartupState – IfguiStartupState is set to Shown then the FIRemote User interface
windowwill appear on the screen at the completion of the startup process. Note that this argument has
no effect ifguiType = None. The state of the window is controlled by
guiWindowStartupState. You can set the state to Maximized, Normal, or Minimized.

theConstructorWarning – Returned value of type ConstructorWarning (None or
StartupRecipeLoadFailure).

warningMessage – Returned warning message string. Empty if None.

Remarks: You can suppress the display of the FIRemote user interface by setting guiType
appropriately. Typically, you would show the user interface during software development in order to aid
in the testing and debugging process. However, there are some applications where it is useful to be able
to show and hide the user interface while the software is running. This is accomplished with the
GUIVisible Property. The constructor warns if the startup recipe has problems loading and a default
recipe is loaded instead.

Return to Index...

AcquireSpectrum
Public Sub AcquireSpectrum(ByRef spectrumWavelengths() As Single,
ByRef spectrumData() As Single)
Public Sub AcquireSpectrum(ByRef spectrumWavelengths() As Single,
ByRef spectrumData() As Single, ByVal flushPipeline As Boolean)
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Public Sub AcquireSpectrum(ByRef spectrumWavelengths() As Single,
ByRef spectrumData() As Single, ByRef secondarySpecWavelengths() As
Single, ByRef secondarySpecData() As Single, ByRef
primarySpecIsReflectance As Boolean)
Public Sub AcquireSpectrum(ByRef spectrumWavelengths() As Single,
ByRef spectrumData() As Single, ByVal secondarySpecWavelengths() As
Single, ByRef secondarySpecData() As Single, ByVal flushPipeline As
Boolean, ByRef primarySpecIsReflectance As Boolean)
Public Sub AcquireSpectrum(ByVal measChannelGuid As Guid, ByRef
spectrumWavelengths() As Single, ByRef spectrumData() As Single)
Public Sub AcquireSpectrum(ByVal measChannelGuid As Guid, ByRef
spectrumWavelengths() As Single, ByRef spectrumData() As Single,
ByVal flushPipeline As Boolean)
Public Sub AcquireSpectrum(ByVal measChannelGuid As Guid, ByRef
primarySpecIsReflectance As BooleanByRef spectrumWavelengths() As
Single, ByRef spectrumData() As Single)
Public Sub AcquireSpectrum(ByVal measChannelGuid As Guid, ByRef
spectrumWavelengths() As Single, ByRef spectrumData() As Single,
ByVal flushPipeline As Boolean, ByRef primarySpecIsReflectance As
Boolean)

measChannelGuid – The GUID of themeasurement channel for which a spectrum should be acquired. If
multiple measurement channels exist, themeasChannelGuid must be specified.

spectrumWavelengths – Array to contain wavelengths ofmeasured spectum data points.

spectrumData –Measured reflectance or transmittance data points.

secondarySpecWavelengths – For systems that can simultaneously acquire reflectance and
transmittance such as the F10-RT, array to contain wavelengths ofmeasured secondary spectum data
points. For all other systems, the returned argument is Nothing.

secondarySpecData – For systems that can simultaneously acquire reflectance and transmittance such
as the F10-RT, array to contain themeasured secondary spectum data points. For all other systems, the
returned argument is Nothing.

flushPipeline – If set to True (default), any data currently being acquired is ignored and new data is
acquired. If set to False, data currently being acquired is returned when acquisition is finished.

primarySpecIsReflectance – Indicates whether the primary spectrum data is Reflectance or
Transmittance.

Remarks: It is important that you catch exceptions which may occur as a result of calling this method.
See the example program for details.

Return to Index...



9 5

ActivateChannelDisplayTab
Public Sub ActivateChannelDisplayTab(ByVal measChannelGuid As Guid)

measChannelGuid – The GUID of themeasurement channel of the corresponding Measurement Tab to
be selected.

Remarks: After execution, the active tab in the FILMeasure GUI will be the specified Measurement Tab.
This method should only be executed if multiple measurement channels exist.

Return to Index...

AnalyzeSpectrum
Public Function AnalyzeSpectrum(ByVal formatSummaryAsRtf As Boolean)
As FIMeasResults
Public Function AnalyzeSpectrum(ByVal formatSummaryAsRtf As Boolean,
ByVal addToHistory As Boolean) As FIMeasResults
Public Function AnalyzeSpectrum(ByVal measChannelGuid As Guid, ByVal
formatSummaryAsRtf As Boolean) As FIMeasResults
Public Function AnalyzeSpectrum(ByVal measChannelGuid As Guid, ByVal
formatSummaryAsRtf As Boolean, ByVal addToHistory As Boolean) As
FIMeasResults

measChannelGuid – The GUID of themeasurement channel for which a spectrum should be analyzed
and optionally added to history. If multiple measurement channels exist, themeasChannelGuid must be
specified.

formatSummaryAsRtf – Themeasurement summary returned by the .ResultsSummary property of the
FIMeasResults object can be formatted as either plain text or as rtf. Formatting the summary as rtf is
advantageous if it will be displayed to the user because then the full set of information including bold
font and colors will be included.

addToHistory – Normally, each analysis result is added to the collection of results displayed in the History
area of FILMeasure. In some cases, it may be advantageous to suppress the addition of a result to the
History area. One example where this may be needed is the case where you wish to analyze a spectrum
with two different measurement recipes and then add only the best result to the History.

Remarks: Themost-recently acquired spectrum can be analyzed by calling this function.

Return to Index...
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AuthenticateRefBac
Public Sub AuthenticateRefBac()
Public Sub AuthenticateRefBac(ByVal measChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a baseline should be
recovered. If multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: Calling this method is equivalent to clicking Baseline… to display the Baseline dialog and then
clicking Recover Last Baseline… to recover an old baseline spectrum. Note that there aremany situations
where an exception may be generated by calling this method. See the example program for details.

Return to Index...

BaselineAcquireBackgroundAfterRef
Public Sub BaselineAcquireBackgroundAfterRef()
Public Sub BaselineAcquireBackgroundAfterRef(ByVal
measChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a background should be
acquired. If multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: This method provides a means to automate what is most commonly called step #3 of the
Baseline procedure (step #4 for F10-RT, “Reflection Only” or “Reflection and Transmittance”. step #2 for
F10RT“Transmittance Only”). As the name of this method implies, you must have previously acquired a
reference spectrum.

Return to Index...

BaselineAcquireReference
Public Sub BaselineAcquireReference()
Public Sub BaselineAcquireReference(ByVal measChannelOrSystemGuid As
Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a reference should be
acquired. If multiple measurement channels exist, themeasChannelGuid must be specified.
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Remarks: This method provides a means to automate what is most commonly called step #2 of the
Baseline procedure. Calling BaselineAcquireReferencemay generate an exception. There are a number of
rules required for successful execution of this method. Unless the acquisition timing mode in the recipe is
set to Manual, you must first callBaselineAcquireSpectrumFromSample. Alternatively, you could call the
variant of this method which accepts a user-supplied reflectance value if you know the sample
reflectance and wish to skip step #1.

Return to Index...

BaselineAcquireReferenceT
Public Sub BaselineAcquireReferenceT()
Public Sub BaselineAcquireReferenceT(ByVal measChannelOrSystemGuid As
Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a Transmittance
reference should be acquired. If multiple measurement channels exist, themeasChannelGuid must be
specified.

Remarks: This method should only be called for the F10-RT. It provides a means to automate step #3 of
the Baseline procedure for “Reflectance Only” or “Reflectance and Transmittance” modes, or step #1 of
the Baseline procedure for “Transmittance Only” mode. No sample should be positioned on stage when
called.

Return to Index...

BaselineAcquireReferenceUsingOldSampleReflectance
Public Sub BaselineAcquireReferenceUsingOldSampleReflectance()
Public Sub BaselineAcquireReferenceUsingOldSampleReflectance(ByVal
measChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a reference should be
acquired. If multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: This method provides a means to automate steps 1 and 2 of the Baseline procedure by
assuming that the sample reflectance is unchanged from what it was the last time a baseline procedure
was performed. Note that an exception may be thrown in some situations including the case where no
prior baseline spectrum exists.

Return to Index...

BaselineAcquireSpectrumFromSample
Public Sub BaselineAcquireSpectrumFromSample()
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Public Sub BaselineAcquireSpectrumFromSample(ByVal
measChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a sample spectrum
should be acquired. If multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: This method provides a means to automate what is most commonly called step #1 of the
Baseline procedure.

Return to Index...

BaselineCommit
Public Sub BaselineCommit()
Public Sub BaselineCommit(ByVal measChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a new baseline should be
commited. If multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: Call this method to finalize the baseline procedure and commit the acquired spectra for use as
a new baselinemeasurement.

Return to Index...

BaselineSetRefMat
Public Sub BaselineSetRefMat(ByVal theRefMat As String)
Public Sub BaselineSetRefMat(ByVal measChannelOrSystemGuid As Guid,
ByVal theRefMat As String)

measChannelOrSystemGuid – The GUID of themeasurement channel for which the referencematerial
should be assigned. If multiple measurement channels exist, themeasChannelGuid must be specified.

theRefMat – The referencematerial as it would normally appear in the list of referencematerials shown
in the Baseline dialog.

Remarks: This method should be called prior to acquiring a reference spectrum

Return to Index...

BaselineShowDialog
Public Sub BaselineShowDialog(ByRef dialogCanceled As Boolean)

dialogCanceled – True if user has canceled the dialog. 
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Remarks: Calling this method will cause the baseline dialog box to be displayed on the screen

Return to Index...

GUIVisible
Public Property GUIVisible As Boolean

Remarks: Setting this property to True will cause the FIRemote user interface to be displayed on the
screen. Note that this will normally cause the user interface window to appear on top of any other
windows. If you wish to keep another window on top of the FIRemote user interface window, it may be
necessary to call .BringToFront on that other window. If the FIRemote object is constructed with
guiType set to None then an exception will be thrown ifGUIVisible is set to True.

Return to Index...

HistoryDeleteAllResults
Public Sub HistoryDeleteAllResults()

Remarks: All measurement results in the History tab are deleted. If the FIRemote object has no user
interface (guiType = None in New()), then there is no measurement history and this function has
no effect.

Return to Index...

IntegrationCycles
Public Property IntegrationCycles() As Integer
Public Property IntegrationCycles(ByVal measChannelGuid As Guid) As
Integer
Public Property IntegrationCycles(ByVal specIndex As
SpectrometerIndex) As Integer
Public Property IntegrationCycles(ByVal measType As
SubsystemMeasType) As Integer
Public Property IntegrationCycles(ByVal measChannelGuid As Guid,
ByVal specIndex As SpectrometerIndex) As Integer
Public Property IntegrationCycles(ByVal measChannelGuid As Guid,
Byval measType As SubsystemMeasType, specIndex As SpectrometerIndex)
As Integer

measChannelGuid – The GUID of themeasurement channel for which to set or get IntegrationCycles.

measType – Specifies which measurement subsystem (Reflectance, Transmittance, etc.).

specIndex – Specifies which spectrometer (Short or Long Wavelengths).
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Remarks: The IntegrationCycles parameter is visible in the dialog Edit Recipe->Acquisition Settings tab in
theMeasurement Timing group under the Usemanually set parameters Radio Button. Calling the
variants of this property without a measChannelGuid is acceptable unless this does not unambiguously
measurement channel. If there is only a single measurement channel, then it is unnecessary to call the
variants of this property that include themeasChannelGuid. If a measurement channel includes multiple
measTypes, but themeasType is not supplied, then the ReflectancemeasType will be addressed. If a
MeasurementType includes multiple spectrometers, but the specIndex is not supplied, then the
ShortWavelength spectrometer will be addressed.

Return to Index...

IntegrationTime_ms
Public Property IntegrationTime_ms() As Double
Public Property IntegrationTime_ms(ByVal measChannelGuid As Guid) As
Double
Public Property IntegrationTime_ms(ByVal specIndex As
SpectrometerIndex) As Double
Public Property IntegrationTime_ms(ByVal measType As
SubsystemMeasType) As Double
Public Property IntegrationTime_ms(ByVal measChannelGuid As Guid,
ByVal specIndex As SpectrometerIndex) As Double
Public Property IntegrationTime_ms(ByVal measChannelGuid As Guid,
Byval measType As SubsystemMeasType, specIndex As SpectrometerIndex)
As Double

measChannelGuid – The GUID of themeasurement channel for which to set or get IntegrationTime_ms.

measType – Specifies which measurement subsystem (Reflectance, Transmittance, etc.).

specIndex – Specifies which spectrometer (Short or Long Wavelengths).

Remarks: The IntegrationTime_ms parameter is visible in the dialog Edit Recipe->Acquisition Settings tab
in theMeasurement Timing group under the Usemanually set parameters Radio Button. See discussion
in IntegrationCycles remarks regarding unsupplied arguments.

Return to Index...

MaximumSamplingTime
Public Property MaximumSamplingTime() As Double
Public Property MaximumSamplingTime(ByVal measChannelOrSystemGuid As
Guid) As Double
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measChannelOrSystemGuid – The GUID of themeasurement channel or measurement system for which
to set or get MaximumSamplingTime.

Remarks: TheMaximumSamplingTime parameter is visible in the dialog Edit Recipe->Acquisition Settings
tab in theMeasurement Timing group under the Usemaximum sampling time Radio Button. See
discussion in IntegrationCycles Remarks regarding unsupplied arguments.

Return to Index...

MeasurementTimingMode
Public Property MeasurementTimingMode() As MeasurementTimingModes
Public Property MeasurementTimingMode(ByVal measChannelOrSystemGuid
As Guid) As MeasurementTimingModes

measChannelOrSystemGuid – The GUID of themeasurement channel or measurement system for which
to set or get MeasurementTimingMode.

Remarks: TheMeasurementTimingMode parameter is visible in the dialog Edit Recipe->Acquisition
Settings tab in theMeasurement Timing group. Available choices are Recommended, Maximum, and
Manual. See discussion in IntegrationCycles Remarks regarding unsupplied arguments.

Return to Index...

MeasChannelGuid
Public ReadOnly Property MeasChannelGuid(ByVal measChannelIndex As
Integer) As Guid
Public ReadOnly Property MeasChannelGuid(ByVal measSystemGuid As
Guid, ByVal measChannelIndex As Integer) As Guid

measSystemGuid – The GUID of a measurement system.

measChannelIndex – The zero-based index of themeasurement channel.

Remarks: Returns the GUID of the specified channel. Note this can be used to obtain the GUID used by all
methods requiring a measChannelGUID. Also note that the relationship between measChannelIndex and
MeasChannelGuid is not static. Future versions of FILMeasure will dynamically reorder this list in
response to an equipment connect/disconnect event. You should not rely on the order of the channels
in the list when attempting to perform a command on a certain channel.

Return to Index...
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MeasChannelGuids
Public ReadOnly Property MeasChannelGuids() As Collection(Of Guid)

Remarks: Returns a collection of GUID for each measurement channel that exists.

Return to Index...

MeasChannelHWName
Public ReadOnly Property MeasChannelHWName(ByVal measChannelGuid As
Guid) As String

measChannelGuid – The GUID of themeasurement channel for which the channel hardware name
should be returned.

Remarks: The hardware name is composed of a system name string and a serial number string separated
by a colon. Example: F20:09A006.

Return to Index...

MeasChannelHWSerialNumber
Public ReadOnly Property MeasChannelHWSerialNumber(ByVal
measChannelGuid As Guid) As String
Public ReadOnly Property MeasChannelHWSerialNumber(ByVal
measChannelGuid As Guid, ByVal spectrometerIndex As Integer) As
String
Public ReadOnly Property MeasChannelHWSerialNumber(ByVal
measChannelGuid As Guid, ByVal subsystemIndex As Integer, ByVal
spectrometerIndex As Integer) As String

measChannelGuid – The GUID of themeasurement channel.

spectrometerIndex – The spectrometer index (to specify which ofmultiple spectrometers in the channel).

subsystemIndex – The subsystem index (to select among multiple subsystems in the channel).

Remarks: Returns the controller hardware serial number of the specified spectrometer. If the
spectrometer or subsystem are not specified, the default index = 0will be used. If there aremultiple
subsystems, a hyphen followed by the subsystem ID is appended to the hardware serial number.
Example for single subsystem: 09A006. Example for multiple subsystem: 09A007-1

Return to Index...
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MeasChannelName
Public ReadOnly Property MeasChannelName(ByVal measChannelGuid As
Guid) As String

measChannelGuid – The GUID of themeasurement channel for which the channel name should be
returned.

Remarks: By default the channel name is the empty string.

Return to Index...

Measure
Public Function Measure(ByVal formatSummaryAsRtf As Boolean) As
FIMeasResults
Public Function Measure(ByVal formatSummaryAsRtf As Boolean, ByVal
addToHistory As Boolean) As FIMeasResults
Public Function Measure(ByVal measChannelGuid As Guid, ByVal
formatSummaryAsRtf As Boolean) As FIMeasResults
Public Function Measure(ByVal measChannelGuid As Guid, ByVal
formatSummaryAsRtf As Boolean, ByVal addToHistory As Boolean) As
FIMeasResults

measChannelGuid – The GUID of themeasurement channel for which a spectrum should be acquired
and analyzed. If multiple measurement channels exist, themeasChannelGuid must be specified.

formatSummaryAsRtf – Themeasurement summary returned by the .ResultsSummary property of the
FIMeasResults object can be formatted as either plain text or as rtf. Formatting the summary as rtf is
advantageous if it will be displayed to the user because then the full set of information including bold
font and colors will be included.

addToHistory – Normally, each analysis result is added to the collection of results displayed in the History
area of FILMeasure. In some cases, it may be advantageous to suppress the addition of a result to the
History area. One example where this may be needed is the case where you wish to analyze a spectrum
with two different measurement recipes and then add only the best result to the History.

Remarks: Calling this function is equivalent to clicking theMeasure button in FILMeasure. Note that if the
Measure button is disabled when you call this function, an exception will be thrown.

Return to Index...

NumberOfChannels
Public ReadOnly Property NumberOfChannels() As Integer
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Remarks: Number ofmeasurement channels that exist.

Return to Index...

NumberOfSpectrometers
Public ReadOnly Property NumberOfSpectrometers(ByVal measChannelGuid
As Guid) As Integer
Public ReadOnly Property NumberOfSpectrometers(ByVal measChannelGuid
As Guid, ByVal subsystemIndex As Integer) As Integer

measChannelGuid – The GUID of themeasurement channel.

subsystemIndex – Thesubsystem index (to specify which ofmultiple subsystems in the channel).

Remarks: The number of spectrometers in the specified subsystem. If subsystemIndex is not provided,
the default index = 0will be used.

Return to Index...

NumberOfSubSystems
Public ReadOnly Property NumberOfSubSystems(ByVal measChannelGuid As
Guid) As Integer

measChannelGuid – The GUID of themeasurement channel.

Remarks: The number of subsystems that compose the specified measurement channel.

Return to Index...

OpticsConfiguration
Public Property OpticsConfiguration() As OpticsConfigSystemTypes
[Get/Set]
Public Property OpticsConfiguration(ByVal measChannelGuid As Guid) As
OpticsConfigSystemTypes [Get/Set]

measChannelGuid – The GUID of themeasurement channel for which the OpticsConfiguration is to be
get/set. If multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: If the OpticsConfigSystemTypes is not be compatible with the hardware an exception will be
thrown.

Return to Index...
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OpenSpectrum
Public Sub OpenSpectrum(ByVal filenameAndPath As String)
Public Sub OpenSpectrum(ByVal filenameAndPath As String, ByVal
measChannelGuid As Guid)

filenameAndPath – The full path and filename (including extension) of the spectrum. If the file cannot be
opened, an exception will be thrown.

measChannelGuid – The GUID of themeasurement channel for a spectrum is to be opened. If multiple
measurement channels exist, themeasChannelGuid must be specified.

Remarks: Unlike the behavior when a spectrum is opened in FILMeasure, the software will not
automatically analyze the spectrum after opening it. If analysis of the spectrum is desired, then the
Analyze function must be called.

Return to Index...

OpenSpectrumFromBuffer
Public Sub OpenSpectrumFromBuffer(ByVal theBuffer As Byte())
Public Sub OpenSpectrumFromBuffer(ByVal theBuffer As Byte(), ByVal
measChannelGuid As Guid)

theBuffer – Byte array containing spectrum. Data in this array must have been created by
SaveSpectrumToBuffer method.

measChannelGuid – The GUID of themeasurement channel for a spectrum which is to be opened. If
multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: See remarks after SaveSpectrumToBuffer

Return to Index...

OperatorID
Public Property OperatorID() As String

Remarks: Get or Set the Operator ID that is visible in the user interface.

Return to Index...
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RecipeInfo
Public ReadOnly Property RecipeInfo() As FIRecipeInfo
Public ReadOnly Property RecipeInfo(measChannelOrSystemGuid) As Guid)
As FIRecipeInfo

measChannelGuid - The GUID of themeasurement channel associated with a measurement recipe. If
multiple measurement channels exist themeasChannelOrSystemGuid must be specified.

Remarks: The FIRecipeInfo object contains an assortment of information about the recipe including
information about the film stack, if appropriate..

Return to Index...

SampleID
Public Property SampleID() As String

Remarks: Get or Set the Sample ID that is visible in the user interface.

Return to Index...

SaveSpectrum
Public Sub SaveSpectrum(ByVal filenameAndPath As String)
Public Sub SaveSpectrum(ByVal filenameAndPath As String, ByVal
ifTextFormatWriteYDataAsPercent As Boolean)

filenameAndPath – The full path and filename (including extension) of the spectrum. The file format is
determined by the extension. Valid file extensions are the same as the extensions listed in the Save
Spectrum dialog windows accessed via the File->SaveMeasured Spectrum menu item in FILMeasure.

ifTextFormatWriteYDataAsPercent – If this version of SaveSpectrum without this parameter is called, the
result is the same as calling the version with this parameter and setting its value to True. Thus, the only
reason to call the second variant of the function is if the spectrum is being saved as a text format (either
.txt or .csv) and the value of this parameter is set to False

Return to Index...

SaveSpectrumToBuffer
Public Sub SaveSpectrumToBuffer( As Byte()
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Remarks: This function allows the caller to rapidly retrieve the complete set of data contained in a
spectrum, thereby avoiding the time that would be consumed if the spectrum were saved to a file. This
may be useful in cases where the caller wishes to rapidly acquire a number of spectra and store them up
for later saving to file or analysis. The contents of the buffer should be considered opaque. Any changes
to the data in the buffer may render the data unusable and/or may not be compatible with future
versions of FILMeasure.

Return to Index...

SetAnalysisWavelengthRange
Public Sub SetRecipeSetAnalysisWavelengthRange(ByVal
measChannelGuidmeasChannelOrSystemGuid As Guid, ByVal
startWavelength_nm As Single, ByVal endWavelength_nm As Single)
Public Sub SetAnalysisWavelengthRange(ByVal startWavelength_nm As
Single, ByVal endWavelength_nm As Single)

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified (since each
measurement channel has its own active recipe).

startWavelength_nm – Starting wavelength for spectrum analysis.

endWavelength_nm – Ending wavelength for spectrum analysis.

Remarks: Setting the wavelength range will also switch the recipe into using a specified wavelength range
instead of using the entire wavelength range visible on the spectrum graph.

Return to Index...

SetMaterial
Public Sub SetMaterial(ByVal measChannelOrSystemGuid As Guid, ByVal
layerNumber As Integer, ByVal materialName As String)
Public Sub SetMaterial(ByVal layerNumber As Integer, ByVal
materialName As String)

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified (since each
measurement channel has its own active recipe).

layerNumber – The layer number for which to modify thematerial.

materialName – String containing name of thematerial.
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Remarks: You can alter thematerial of a layer in the current recipe using themethod. An exception will be
thrown if the layer number is out-of-bounds or thematerial does not exist.

Return to Index...

SetN
Public Sub SetN(ByVal measChannelOrSystemGuid As Guid, ByVal
layerNumber As Integer, ByVal refractiveIndex As Single)
Public Sub SetN(ByVal layerNumber As Integer, ByVal refractiveIndex
As Single)

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified (since each
measurement channel has its own active recipe).

layerNumber – The layer number for which to set the refractive index.

refractiveIndex – New refractive index value for layer.

Remarks: You can alter thematerial of a layer in the current recipe using themethod. An exception will be
thrown if the layer number or refractive index are out-of-bounds.

Return to Index...

SetRecipe
Public Sub SetRecipe(ByVal measChannelOrSystemGuid As Guid, ByVal
recipeName As String)
Public Sub SetRecipe(ByVal recipeName As String)

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified (since each
measurement channel has its own active recipe).

recipeName – The recipe name to be selected must exist in the list of recipes. Note that you can select
recipes contained in subfolders by specifying the relative path, using the backslash character ‘\’ to
separate folder names as is conventional in path naming.

Remarks: The current spectrum will not be automatically reanalyzed when a new recipe is selected. To
reanalyze the spectrum you must callAnalyzeSpectrum.
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Return to Index...

SetRoughness
Public Sub SetRoughness(ByVal measChannelOrSystemGuid As Guid, ByVal
layerNumber As Integer, ByVal roughness_nm As Single)
Public Sub SetRoughness(ByVal layerNumber As Integer, ByVal
roughness_nm As Single)

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified (since each
measurement channel has its own active recipe).

layerNumber – The layer number for which to modify the roughness.

roughness_nm – Roughness value which will appear in the Layers tab of the recipe for the specified layer.
Units are nanometers.

Remarks: You can alter the roughness of a layer in the current recipe using themethod. An exception will
be thrown if the layer number or roughness are out-of-bounds.

Return to Index...

SetThickness
Public Sub SetThickness(ByVal measChannelOrSystemGuid As Guid, ByVal
layerNumber As Integer , ByVal thickness_nm As Single)
Public Sub SetThickness(ByVal layerNumber As Integer, ByVal
thickness_nm As Single)

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified (since each
measurement channel has its own active recipe).

layerNumber – The layer number for which to modify the thickness.

thickness_nm – Thickness value which will appear in the Layers tab of the recipe for the specified layer.
Units are nanometers.

Remarks: You can alter the thickness of a layer in the current recipe using themethod. An exception will
be thrown if the layer number or thickness is out-of-bounds.

Return to Index...
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SetThicknessRange
Public Sub SetThicknessRange(ByVal layerNumber As Integer, ByVal
layerNumber As Integer , ByVal thicknessRange As Double)
Public Sub SetThicknessRange(ByVal measChannelOrSystemGuid AsGuid,
ByVal layerNumber As Integer, ByVal thicknessRangePercent As Double)

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified (since each
measurement channel has its own active recipe).

layerNumber – The layer number for which to modify the thickness.

thicknessRangePercent – Thickness range which will appear in the Layers tab of the recipe for the
specified layer. Note that the value accepted by this function is always a percentage, regardless of the
setting in the recipe editor which shows the range as either a percentage or a thickness. Minimum value
is zero. There is no maximum value.

Remarks: You can alter the thickness range setting for a layer in the current recipe using themethod. An
exception will be thrown if the layer number or thickness range are out-of-bounds.

Return to Index...

SpectrometerDiagnostics
Public ReadOnly Property SpectrometerDiagnostics()
AsFISpecDiagnosticsInfo()
Public ReadOnly Property SpectrometerDiagnostics(ByVal
measChannelGuid AsGuid)As FISpecDiagnosticsInfo()
Public ReadOnly Property SpectrometerDiagnostics(ByVal
measChannelGuid As Guid, ByVal subsystemIndex As Integer) As
FISpecDiagnosticsInfo()

measChannelGuid – The GUID of themeasurement channel.

subsystemIndex – The subsystem index (to select among multiple subsystems in the channel).

Remarks: Returns an array of objects containing information about the spectrometers. Information
includes integration time, peak raw signal intensities of reference and background spectra, etc.

Return to Index.

SpectrometerType
Public Property SpectrometerType() As SpectrometerTypes
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Public Property SpectrometerType(ByVal measChannelOrSystemGuid
AsGuid) As SpectrometerTypes
Public Property SpectrometerType(ByVal measType AsSubsystemMeasType)
As SpectrometerTypes
Public Property SpectrometerType(ByVal measChannelOrSystemGuid As
Guid, ByVal measType As SubsystemMeasType) As SpectrometerTypes

measChannelOrSystemGuid – The GUID of themeasurement channel or measurement system for which
to set or get SpectrometerType.

measType – Specifies which measurement subsystem (Reflectance, Transmittance, etc.).

Remarks: The SpectrometerType parameter is visible in the dialog Edit Recipe->Acquisition Settings tab in
theMeasurement Timing group. Available choices are All, ShortwavelengthsOnly,
LongWavelengthsOnly, and ExtendedWavelengths. The All and ExtendedWavelengths values select the
corresponding options in the Acquisition Settings in the Recipe, but these two options result in the same
behavior. See discussion in IntegrationCycles Remarks regarding unsupplied arguments.

Return to Index.

ActivateMonitorDisplayTab
Public Sub ActivateMonitorDisplayTab()
Public Sub ActivateMonitorDisplayTab(ByVal measSystemGuid As Guid)

measSystemGuid – The GUID of themeasurement System. If multiple measurement channels exist, the
measChannelGuid must be specified (since each measurement channel has its own active recipe).

Remarks: This function is provided to permit synchronization of the FILMeasure user interface with the
user interface of a client program.

Return to Index...

BaselineExistsAndIsAuthenticated
Public Function BaselineExistsAndIsAuthenticated(ByRef
authenticationIsPossible As Boolean) As Boolean
Public Function BaselineExistsAndIsAuthenticated
(measChannelOrSystemGuid As Guid, ByRef authenticationIsPossible As
Boolean) As Boolean

authenticationIsPossible – If baseline is not authenticated, it is possible to authenticate it when
authenticationIsPossible = True.
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Remarks: In some cases, it is desirable to check whether the baseline is already authenticated and if not
whether it is possible to authenticate it. The client software has the option of automatically
authenticating the baseline if that is desirable.

Return to Index...

BaselineHardwareAdjustInhibit
Public Property BaselineHardwareAdjustInhibit() As Boolean
Public Function BaselineHardwareAdjustInhibit(measChannelOrSystemGuid
As Guid) As Boolean

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified.

Remarks: Somemeasurement systems include hardware that must be periodically adjusted. The
adjustment procedure happens automatically during the baseline process unless it is inhibited. The
adjustment process may take several minutes to complete. This property allows the client software to
control when the adjustment process is accomplished so that it can be performed at a convenient time.
SeeGetBaselineHardwareAdjustStatus() for additional information.

Return to Index...

GeneralPurposeIOIsSupported
Public ReadOnly Property GeneralPurposeIOIsSupport() As Boolean

Remarks: Primary purpose of this property is to permit the example program to hide or show the
General Purpose IO controls. This property will be True for equipment that has the General Purpose IO
hardware.

Return to Index...

GeneralPurposeIOReadValue
Public Function GeneralPurposeIOReadValue() As Byte

Remarks: Returns a single byte containing the current values of the general purpose IO logic input
signals. Bit value of 1means that the input voltage is in the logic high state. These input signals are only
available on certain types of equipment.

Return to Index...
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GeneralPurposeIOSetValue
Public Sub GeneralPurposeIOSetValue(newValue As Byte)

newValue - New values for the output bits.

Remarks: Sets the output state of the general purpose IO logic output signals. Setting a bit to 1will set
the corresponding output to the logic high state. These output signals are only available on certain types
of equipment.

Return to Index...

GetBaselineHardwareAdjustStatus
Public Function GetBaselineHardwareAdjustStatus() As
BaselineHardwareAdjustStatus
Public Function GetBaselineHardwareAdjustStatus
(measChannelOrSystemGuid As Guid) As BaselineHardwareAdjustStatus

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified.

Remarks: See BaselineHardwareAdjustInhibit() for additional information. Members of the
GetBaselineHardwareAdjustStatus Class include:

NeedsPeriodicAdjustment (Boolean) – True if the hardware is of a type that will need to be adjusted
periodically.

AdjustmentRequiredNow (Boolean) – True if adjustment is required before Baseline can be completed; if
adjustment is required, but inhibited, then Baselinemethods will throw an exception when called.

AdjustmentRecommendedNow (Boolean) – True if adjustment is recommended.

AdjustmentPeriodHours (Single) – time period in hours between recommended adjustments.

TimeToNextRecommendedAdjustmentHours (Single) – time until the next recommended adjustment; a
negative number represents the amount of time that has passed since an adjustment has become
recommended.

Return to Index...

MaterialPath
Public ReadOnly Property MaterialPath() As String
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Remarks: Reports the currently effective path for Material Files.

Return to Index...

MaterialPathCustom
Public Property MaterialPathCustom() As String

Remarks: This property allows a client to set/get a custom path for Material Files. If this property is set to
an empty value or an invalid path, then the effective path will be the default path.

Return to Index...

MeasSystemGuid
Public ReadOnly Property MeasSystemGuid(ByVal measSystemIndex As
Integer) As Guid

measSystemIndex – The zero-based index of the system.

Remarks: Returns the GUID of the specified system. Note this can be used to obtain the GUID used by all
methods requiring a measSystem GUID. Also note that the relationship between measSystemIndex and
MeasSystemGuid is not static. Future versions of FILMeasure will dynamically reorder this list in
response to an equipment connect/disconnect event. You should not rely on the order of the systems in
the list when attempting to perform a command on a certain system.

Return to Index...

MeasSystemGuids
Public ReadOnly Property MeasSystemGuids() As Collection(Of Guid)

Remarks: Returns a collection of GUIDs containing one item for each measurement system that exists.

Return to Index...

MeasSystemHWName
Public ReadOnly Property MeasSystemHWName(ByVal systemGuid As Guid)
As String

systemGuid – The GUID of a measurement system.
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Remarks: The hardware name is composed of a system name string and a serial number string separated
by a colon. Example: F37:09A006

Return to Index...

MeasSystemName
Public ReadOnly Property MeasSystemName(ByVal systemGuid As Guid) As
String

systemGuid – The GUID of a measurement system.

Remarks: The default system name is the empty string.

Return to Index...

NumberOfSystems
Public ReadOnly Property NumberOfSystems() As Integer

Remarks: Number ofmeasurement systems that exist.

Return to Index...

RecipePath
Public ReadOnly Property RecipePath() As String

Remarks: Reports the currently effective path for Measurement Recipes.

Return to Index...

RecipePathCustom
Public Property RecipePathCustom() As String

Remarks: This property allows a client to set/get a custom path for Measurement Recipes. If this
property is set to an empty value or an invalid path, then the effective path will be the default path.

Return to Index...

SaveImage
Public Sub SaveImage(ByVal filenameAndPath As String)
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Remarks: Save image from most-recently acquired spectrum as a separate file.

Return to Index...

SetAutoFocus
Public Property SetAutoFocus As Boolean

Remarks: Get or set the state of the Use AutoFocus checkbox in the Acquisition Settings tab of the
current recipe.

Return to Index...

SetRecipeModeToSpectrumAnalysis
Public Sub SetRecipeModeToSpectrumAnalysis()
Public Sub SetRecipeModeToSpectrumAnalysis(ByVal
measChannelOrSystemGuid As Guid)
Public Sub SetRecipeModeToThickness() 
Public Sub SetRecipeModeToThickness(ByVal measChannelOrSystemGuid As
Guid)

measChannelOrSystemGuid – The GUID of one of themeasurement channels in a muliple channel
system or the GUID of the system. If multiple measurement channels exist, themeasChannelGuid must
be specified.

Remarks: If Spectrum Analysis recipes are supported by the hardware or add-on licenses, then the
Measure tab in the user interface will display a tab control that allows the user to switch modes. The tab
associated with the Spectrum Analysis recipemode is labeled “AR” or “Spectrum”. The other tab is
labeled “HC” or “Thickness” or “Thickness, n, k, r”. Calling SetRecipeModeToSpectrumAnalysis or
SetRecipeModeToThickness is the same as clicking on the Spectrum or Thickness tab in the user
interface.

Return to Index...

ShutdownRequestedHandler
Public Delegate SubShutdownRequestedHandler(ByVal e As
Windows.Forms.FormClosingEventArgs)
Public Event ShutdownRequested As ShutdownRequestedHandler

e – The standard argument type for a form about to close.
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Remarks: The client software can prohibit closing of the software by setting e.Cancel to True.
Alternatively, the client softwaremay wish to perform certain actions prior to allowing the FIRemote class
to shut down.

Return to Index...

SetRecipeSpectrumAnalysis
Public Sub SetRecipeSpectrumAnalysis(ByVal recipeName As String)
Public Sub SetRecipeSpectrumAnalysis(ByVal measChannelOrSystemGuid As
Guid, ByVal recipeName As String)
Public Sub SetRecipeThickness() 
Public Sub SetRecipeThickness(ByVal measChannelOrSystemGuid As Guid,
ByVal recipeName As String)

measChannelOrSystemGuid – The GUID of one of themeasurement channels in a multiple channel
system or the GUID of the system. If multiple measurement channels exist, themeasChannelGuid must
be specified.

recipeName – The recipe name to be selected must exist in the list of recipes. Note that you can select
recipes contained in subfolders by specifying the relative path, using the backslash character ‘\’ to
separate folder names as is conventional in path naming.

Remarks: Same as SetRecipeModeToSpectrumAnalysis or SetRecipeModeToThickness, but caller
specifies name of recipe to load during recipemode switch.

Return to Index...

ShuttingDown
Public Event ShuttingDown()

Remarks: Client software can add an event handler for this event in order to facilitate performing any
necessary shut-down actions. This event is primarily used in order to permit client software to react to
closing of the FIRemote user interface.

Return to Index...

SystemAutoSave
Public Property SystemAutoSave() As Boolean
Public Property SystemAutoSave(ByVal systemGuid As Guid) As Boolean

systemGuid – The GUID of a measurement system.
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Remarks: You can set or get the state of the AutoSave setting using this property. Note that setting a
new state for SystemAutoSave will not affect an on-going monitor process, but will take effect the next
time a new set of data starts being collected.

Return to Index...

SystemAutoSaveBaseFileNameAndPath
Public Property SystemAutoSaveBaseFileNameAndPath() As String
Public Property SystemAutoSaveBaseFileNameAndPath(ByVal systemGuid As
Guid) As String

systemGuid – The GUID of a measurement system.

Remarks: You can set or get the base filename and path for the AutoSave file using this property. The full
filename is generated by appending a date and time stamp to the base filename. Note that setting a new
filenamewill not affect an on-going monitor process, but will take effect the next time a new set of data
starts being collected.

Return to Index...

SystemMeasure
Public Function SystemMeasure() As FIMeasResultValuesOnly
Public Function SystemMeasure(ByVal
deleteAccumulatedDataBeforeMeasure As Boolean) As
FIMeasResultValuesOnly
Public Function SystemMeasure(ByVal systemGuid As Guid) As
FIMeasResultValuesOnly
Public Function SystemMeasure(ByVal systemGuid As Guid, ByVal
deleteAccumulatedDataBeforeMeasure As Boolean) As
FIMeasResultValuesOnly

deleteAccumulatedDataBeforeMeasure – There is no analog for this parameter in the user interface.
Setting this parameter to True causes any existing accumulated data points to be deleted before the
measurement is performed.

systemGuid – The GUID of a measurement system.

Remarks: Acquire and measure on all channels in a system. Measurement is performed simultaneously
on all channels. Measured results are contained in an FIMeasResultValuesOnly object.

Return to Index...
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SystemMeasurementCompletedEventHandler
Public Delegate Sub SystemMeasurementCompletedEventHandler(ByVal
systemGuid As Guid, ByVal theResults As FIMeasResultValuesOnly)
Public Event SystemMeasurementCompleted As
SystemMeasurementCompletedEventHandler

systemGuid – The GUID of a measurement system.

Remarks: This event is raised upon completion of a SystemMeasure task and after each measurement
during a SystemMonitor process. You should avoid performing lengthy operations (such as writing data
to a file) in the handler for this event because themonitor process will be halted until the handler
function exits. If execution of a lengthy operation is needed, you should invoke a different thread to
perform the operation. If the event is raised as a result of completing a SystemMeasure task, then you
will need to exercise care to avoid creating a threading deadlock. A deadlock will occur if you invoke the
thread which called SystemMeasure in the handler for this event because that thread will not return
from SystemMeasure until all the event handlers have finished executing. See the FIRemoteTest example
program to see one way to avoid the deadlock problem.

Return to Index...

SystemStartMonitoring
Public Sub SystemStartMonitoring()
Public Sub SystemStartMonitoring(ByVal systemGuid As Guid)

systemGuid – The GUID of a measurement system.

Remarks: This function starts a monitoring process

Return to Index...

SystemStopMonitoring
Public Sub SystemStopMonitoring()
Public Sub SystemStopMonitoring(ByVal systemGuid As Guid)

Remarks: This function stops a monitoring process.

Return to Index...
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FIRemoteCOM dll
The dll is automatically included whenever FILMeasure is installed. Since the dll references the
corresponding .exe file it is located inside the FILMeasure folder in the Program Files (or Program Files
(x86) on 64-bit systems) path. The best way to learn how to use the dll is to examine the example Excel
workbook that is included with the software. The workbook has the same name as the dll, but has the
extension .xlsm and is located in the same folder as the dll. When you open the . xlsm file for the first
time, you will see a warning banner as shown below.

You must click the Enable Content button in order to allow the code associated with the buttons on the
worksheets to run. If you do not see the security warning when you open the spreadsheet, then you
may need to modify settings in Excel using the Trust Center. The exact procedure varies, depending on
which version of Excel you are using.

To see the example source code, click the Developer tab on the ribbon. Then click Visual Basic and
double-click the ThisWorkbook object.

Reference for FIRemote Class in FIRemoteCOM dll:

Methods, Properties, and Events:
Public Sub AcquireSpectrum(ByRef spectrumWavelengths() As Single,
ByRef spectrumData() As Single)
arguments – Same as FIRemote Class

Remarks: See remarks for AcquireSpectrum() in FIRemote Class.

Public Sub AuthenticateRefBac()
arguments – Same as FIRemote Class

Remarks: See remarks for AuthenticateRefBac() in FIRemote Class.

Public Sub BaselineAcquireBackgroundAfterRef()
arguments – Same as FIRemote Class

Remarks: See remarks for BaselineAcquireBackgroundAfterRef() in FIRemote Class.

Public Sub BaselineAcquireReference()
arguments – Same as FIRemote Class

Remarks: See remarks for BaselineAcquireReference() in FIRemote Class.
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Public Sub BaselineAcquireSpectrumFromSample() 
arguments – Same as FIRemote Class

Remarks: See remarks for BaselineAcquireSpectrumFromSample() in FIRemote Class.

Public Sub BaselineCommit() 
arguments – Same as FIRemote Class

Remarks: See remarks for BaselineCommit() in FIRemote Class.

Public Sub BaselineSetRefMat() 
arguments – Same as FIRemote Class

Remarks: See remarks for BaselineSetRefMat() in FIRemote Class.

Public Sub Measure(ByVal formatSummaryAsRtf As Boolean, ByRef
measLayerThickness() As Single, ByRef measGOF As Single, ByRef
summary As String)

formatSummaryAsRtf – Themeasurement summary can be formatted as either plain text or as rtf.
Formatting the summary as rtf is advantageous if it will be displayed to the user because then the full set
of information including bold font and colors will be included.

measLayerThickness – Array containing thickness of all layers. Thickness of Layer 1 is in index 1 in the
array.

measGOF –Measured Goodness Of Fit parameter.

Summary – Same as text which appears in Results area in Measure tab.
Remarks: See remarks forMeasure() in FIRemote Class.

Public Sub SetRecipe(recipeName As String)

Arguments and Remarks – See documentation for SetRecipe in FIRemote Class.

End User Software License
Important – Read carefully: This Agreement (“Agreement”) is a legal agreement between you (both you,
individually and your company entity) and KLA Corporation. (“Licensor” or “KLA”) The FILMeasure
software (the “Software”) subject to this Agreement and any accompanying documentation is for your
use solely and exclusively with an authorized device manufactured by or for KLA (“KLA Device”).
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By downloading, installing, copying or otherwise using the Software you
expressly agree to be bound by all of the terms of this Agreement. This Agreement is
displayed for you to read prior to using the Software. If you choose not to accept, or do not agree with all
of the provisions of this Agreement, do not download, install or use the Software but, instead delete it
and, if applicable, request from the authorized KLA distributor from whom you purchased the Software
license, a full refund of any fees you paid for the Software license.

LICENSE
This license agreement (“license”) permits you to use one copy of the Software on any single computer.
The Software is owned by KLA and is protected by United States copyright law and international treaty
provisions. Therefore, this software should be treated as any other copyrighted material except that you
may either: (1) make one copy of the Software for archival backup purposes, or (2) copy the Software to a
single hard disk in all cases, solely for use with a KLA Device. If the Software is used on a networked
computer system wheremore than one computer can access the Software provisions must bemade to
insure that the number of concurrently executing copies of the Software cannot exceed the number of
licenses.

You may transfer the Software and all rights under this Agreement to another party together with a copy
of this Agreement if the other party agrees to accept the terms and conditions of this Agreement. If you
transfer the Software, you must at the same time either transfer all copies (including any prior versions)
in any form to the same party or destroy any copies not transferred.

RESTRICTIONS
You may not use, disclose, distribute, copy, modify, rent, lease, loan, resell, network or transfer the
Software, or any copy, modification or merged portion thereof, in whole or in part, to any third party
except as expressly specified in this Agreement. You agree to provide reasonable security precautions to
prevent unauthorized access to or use of the Software as proscribed herein. You agree not to decompile,
reverse engineer, disassemble or otherwise reduce the Software to a human perceivable form and you
agree not to permit any person or entity to do so. You shall not remove, alter, cover, or obscure any
confidentiality, trade secret, proprietary, or copyright notices, trademarks, proprietary, patent, or other
identifying marks or designs from any component of the Software, and you shall reproduce and include
in all copies of the Software the copyright notice(s) and proprietary legend(s) of KLA and its licensors as
they appear in the Software.
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SOURCE CODE
If source code to the Software was supplied to you, then you may modify and use that source code in
place of the executable version of the Software, but no further rights to distribution or use are granted.
You acknowledge that you have no obligation to createmodifications of the Software source code
(“Licensed Revisions”) nor to disclose such Licensed Revisions to Licensor. You acknowledge that by
making Licensed Revisions, the underlying Softwaremay not be compatible with any future versions of
the Software that Licensor might offer (in Licensor’s sole discretion), and you agree to assume such risk.
Continuing for the term of this Agreement, you hereby grant to Licensor and its affiliates a limited non-
transferable, non-exclusive, worldwide, fully paid-up, royalty-free license (with the right to sublicense) to
make, use, sell, offer to sell, import, export and otherwise distribute such Licensed Revisions under any
of your patents that, if not authorized, would be directly or indirectly infringed by themanufacture, use,
sale, offer to sell or other distribution of the Licensed Revisions. You may not combine or distribute the
Software or Licensed Revisions with Open Source Software (as defined below) or with software developed
using Open Source Software (e.g., tools) in a manner that subjects the Software and Licensed Revisions
or any portion thereof to any license obligations of such Open Source Software. "Open Source Software"
means any software licensed under terms requiring that other software combined or distributed with
such software: (i) be disclosed or distributed in source code form; (ii) be licensed on terms inconsistent
with the terms of this Agreement.

TERM
This Agreement is effective until terminated. You may terminate it at any time by destroying the Software
together with all copies, modifications and merged portions in any form. This Agreement will
immediately and automatically terminate without notice if you fail to comply with any term or condition
of this Agreement. You agree upon termination to cease using and promptly destroy the Software and
Licensed Revisions together with all copies in any form.

GOVERNMENT LICENSEE
If you are acquiring the Software on behalf of any unit or agency of the United States Government, the
following provisions apply:
The Government acknowledges the licensor’s representation that the Software and its documentation
were developed at private expense and no part of them is in the public domain. The Software is a
"commercial item," as that term is defined at 48 C.F.R. 2.101 (OCT 1995), consisting of "commercial
computer software" and "commercial computer software documentation," as such terms are used in 48
C.F.R. 12.212 (SEPT 1995). All U.S. Government licensees and end users acquire the Software with only
those rights set forth herein.

EXPORT LAW ASSURANCES
You acknowledge and agree that the Software is subject to restrictions and controls imposed by the
United States Export Administration Act (the “Act”) and the regulations thereunder. You agree and certify
that neither the Software nor any direct product thereof is being or will be acquired, shipped, transferred
or re-exported, directly or indirectly, into any country prohibited by the Act and the regulations
thereunder or will be used for any purpose prohibited by the same.
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DISCLAIMER OF WARRANTIES. EXCEPT TO THE EXTENT OF ANY LIMITEDWARRANTY PROVIDED BY THE
SELLER, THE SOFTWARE IS FURNISHED "AS-IS", AND TO THEMAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, LICENSORMAKES NOWARRANTY, EXPRESS, IMPLIED OR STATUTORY, INCLUDING ANY
IMPLIEDWARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, TITLE OR NON-
INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE SECRETS OR OTHER INTELLECTUAL
PROPERTY RIGHTS. LICENSOR DOES NOTWARRANT THAT THE SOFTWARE IS FREE FROM BUGS, VIRUSES,
ERRORS OR OTHER PROGRAM LIMITATIONS. YOU AGREE TO USE YOUR INDEPENDENT JUDGMENT IN
DEVELOPING YOUR PRODUCTS. YOU ACKNOWLEDGE AND AGREE THAT LICENSOR IS UNDER NO
OBLIGATION TO INSTALL, MAINTAINOR SUPPORT THE SOFTWARE, OR PROVIDE UPGRADES OR NEW
RELEASES THEREOF, SHOULD LICENSOR PROVIDE ANY ASSISTANCE LICENSORMAKES NOWARRANTIES
WITH RESPECT TO ANY SUCH ASSISTANCE. YOU ASSUME THE ENTIRE RISK ARISING OUT OF THE USE OR
PERFORMANCE OF THE SOFTWARE AND ANY SYSTEMS OR PRODUCTS YOUDESIGNUSING THE
SOFTWARE.
EXCLUSION OF DAMAGES. TO THEMAXIMUM EXTENT PERMITTED BY LAW, IN NO EVENT SHALL
LICENSOR, OR ITS EMPLOYEES, OFFICERS, DIRECTORS, AGENTS, AFFILIATES OR ANY APPLICABLE
LICENSOR (TOGETHER THE “REPRESENTATIVES”), BE LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL,
PUNITIVE OR CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO, DAMAGES FOR ANY LOSS OF
USE, LOSS OF TIME, INCONVENIENCE, COMMERCIAL LOSS OR LOST PROFITS, SAVINGS OR REVENUES,
HOWEVER CAUSED, ONANY THEORY OF LIABILITY, IN CONNECTIONWITH OR ARISING OUT OF THIS
AGREEMENT, THE SOFTWARE, THE LICENSED REVISIONS EVEN IF LICENSOR REPRESENTATIVES HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF A REMEDY SET FORTH HEREIN IS FOUND
TO HAVE FAILED OF ITS ESSENTIAL PURPOSE. IN NO EVENT SHALL LICENSOR’S AGGREGATE LIABILITY
UNDER THIS AGREEMENT EXCEED USD $500.00 OR THE FEES PAID BY YOU FOR THE SOFTWARE UNDER
THIS AGREEMENT. THE LIMITATIONS OF DAMAGES SET FORTH ABOVE ARE FUNDAMENTAL ELEMENTS OF
THE BASIS OF THE BARGAIN BETWEEN LICENSOR AND YOU.
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GENERAL
This Agreement will be governed by the laws of the State of California, U.S.A. without regard to its conflict
of law provisions. If a court of competent jurisdiction finds any provision of the Agreement to be
unenforceable, that provision will be enforced to themaximum extent possible to effectuate the intent of
the parties, and the remainder of the Agreement will continue in full force and effect. Failure of Licensor
to enforce any terms of this Agreement shall not be deemed or considered a waiver of future
enforcement of that or any other term in this Agreement and no consent, waiver, or excuse by Licensor,
express or implied, constitutes a subsequent consent, waiver or excuse. You acknowledge that you have
read this Agreement, understand it and agree to be bound by its terms and conditions. You further agree
that it is the complete and exclusive statement of the agreement between us which supersedes any
proposal or prior agreement, oral or written, and any other communications between us in relation to
the subject matter of this Agreement. This Agreement shall bemodified only by a written instrument
signed by a duly authorized representative of Licensor, or from time to time, Licensor may modify or
change the terms and conditions of this Agreement and supersede the terms of any prior version of this
Agreement, in connection with any supplemental, different or new terms that might apply to an update
or upgrade of the Softwaremade available by Licensor, in Licensor’s sole discretion. Your continued use
of the Software after you download and accept the new, additional or changed terms applicable to such
update or upgrade will indicate your agreement to the change to this Agreement. You may not sell,
assign, transfer, delegate, convey, pledge, encumber or otherwise dispose of, by operation of law or
otherwise, the Software, Licensed Revisions or this Agreement, or any rights or obligations hereunder.
Licensor may assign this Agreement, and any or all of its rights and duties under this Agreement, without
prior notice to you or your consent. You hereby warrant and represent that you have obtained all
authorization and other applicable consents required empowering you to enter into this Agreement.
Rights and obligations under this Agreement which by their nature should survive, will remain in effect
after termination or expiration of this Agreement.
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